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Chapter 1: Introduction

Welcome to the EditShare Version 7 Editor's Guide. This document introduces 
you to the purpose and functions of your EditShare system, explains the 
concepts you’ll need to understand to use it effectively, and describes workflow 
procedures. The Editor's Guide is designed not only for editors but also 
administrators, technical support specialists, and anyone else who uses the 
EditShare system.

The manual begins by providing a high-level overview of what EditShare is and 
how you use it to store and share media files and metadata. It provides specific 
instructions for connecting to EditShare on Windows and Macintosh 
computers, explains the concept of Media Spaces and how EditShare facilitates 
sharing media, discusses the other Spaces EditShare provides, and presents 
instructions for sharing files. Information specifically for users of individual 
non-linear editing applications (NLEs) is also included, as well as a 
comprehensive Index.

See the following topics:

• Additional Documentation

• Technical Support

• Chapter 2: Overview

• Chapter 3: Getting Started as an Editor

• Chapter 4: Media Spaces

• Chapter 5: Metadata Spaces

• Chapter 6: Acting as a Limited Administrator

• Chapter 7: Important Things to Know When Using EditShare with Avid

• Chapter 8: Using EditShare with Final Cut Pro 6 and 7

• Chapter 9: Using EditShare with Final Cut Pro X

• Chapter 10: Using EditShare with Adobe Premiere Pro

• Appendix A: Traditional Media Spaces
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Additional Documentation

The following documents are also available from EditShare:

• EditShare Administrator’s Guide

• EditShare QuickStart Network Configuration Guide

• Optimizing Workstations for EditShare

In addition, the following specialized guides are available for customers who 
purchase optional features:

• EditShare Guide to iSCSI Option

• EditShare Ark Setup and User’s Guide

• EditShare Flow client guides

Finally, you might also want to read guides specific to third-party software such 
as the Avid editing applications or Final Cut Pro.

Technical Support

For questions not addressed in our documentation, contact EditShare 
Technical Support at support@editshare.com. Have the exact version number 
of your EditShare implementation, operating system, and editing software 
ready.



Chapter 2: Overview

This chapter introduces you to the high-level concepts you need to understand 
in order to use EditShare.

See the following topics:

• What is EditShare?

• EditShare Administrator

• EditShare Workflows

• Metadata and Media Files

What is EditShare?

Your EditShare system is a Network Attached Storage (NAS) server or group of 
servers with hardware and software that are highly optimized for video editing. 
It provides a networked file system for both media files and metadata that 
enables multiple editors to collaborate on projects. Editors can work with the 
same media files, bins, and sequences in a controlled fashion that limits the 
opportunities for editors to accidentally or maliciously interfere with each 
others' work.

See the following topics:

• "EditShare Hardware" on page 10

• "EditShare Spaces" on page 11

EditShare Hardware

The EditShare system is a high-performance, high-bandwidth, powerful storage 
system. Its complexity is hidden from the editors and other people using the 
system. You simply see a group of remote drives that appear to your systems just 
like other local hard drives built into your computer or connected via FireWire, 
USB, or Thunderbolt. A simple utility, EditShare Connect, allows you to 
connect to the drives you need and perform sharing operations.
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EditShare Spaces

The purpose of EditShare is to provide Spaces in which you can store data. You 
can access these Spaces in a similar manner as physical hard drives connected to 
your computer, even though they are actually located on a storage array on the 
EditShare server and accessed over your network. These kinds of network 
Spaces are referred to by a variety of names. Your workstation’s operating 
system might refer to them as network drives, shares, folders, volumes, or 
directories. They all mean essentially the same thing: places on the network 
where you can store data.

Once you have logged in to EditShare (as described in "Logging in with 
EditShare Connect" on page 22), you will see the Spaces available to you in 
EditShare Connect as well as in Windows Explorer or the OS X Finder. You can 
access several types of Spaces, each with its own purpose. (Most organizations 
use only a few types of Spaces, not all of them.)

Type of Space
Space 

Subtype Description
For more 

information

Media Space Stores media files. Different types of Media Spaces use different 
strategies to manage the way NLE systems can access the data 
and to protect media from accidental modification or deletion 
as shown below. Access to each Media Space is restricted to 
specified users.

See "Chapter 4: 
Media Spaces" on 
page 36.

Avid Style Avid Style Sharing provides bin-locking and media sharing 
that works the same way as Avid's Unity and Isis storage. 

See “Introduction 
to Avid Style and 
Avid MXF Media 
Spaces” on page 39 
and “EditShare 
Avid Style Sharing” 
on page 78.

Avid MXF For Avid editing applications only. Each editor owns one or 
more folders. The media in each editor’s folders are read-only 
to other editors. Each editor can modify or delete the files in 
his or her own folders, but not in another user’s folders. The 
Administrator can protect files to prevent deletion, even by the 
original creator. Maintenance Mode allows one user to 
organize or delete any files, even those the user doesn’t own.

See "Avid MXF 
Media Spaces in 
Detail" on page 51.

Managed For all NLEs except Avid. Editors can modify or delete their 
own files, but not another user’s files. The Administrator can 
protect files to prevent deletion, even by the original creator. 
Maintenance Mode allows one user to organize or delete any 
files.

See "Managed 
Media Spaces" on 
page 62.
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NOTE:  EditShare recommends against using Traditional Spaces, a legacy option that 
may be available when upgrading from older versions of EditShare, and you can no 
longer create new non-Avid Traditional Spaces. EditShare recommends creating and 
using Avid MXF or Avid Style spaces for Avid media, Avid Style or Avid Shared Project 
Spaces for Avid project files, or Managed and Unmanaged Spaces for non-Avid media 
and project files. If you are using Traditional Spaces on your site, see "Appendix A: 
Traditional Media Spaces" on page 163.

Unmanaged Any editor can modify or delete any file. No protection is 
provided against accidental or malicious modification or 
deletion.

See "Unmanaged 
Media Spaces" on 
page 67.

Universal Universal Media Spaces are only for use with EditShare Flow. 
For more information, see your Flow documentation.

Private Files 
Space

Small private space for each user to store project files. Media 
files not permitted.

See "Private Files 
Spaces" on page 75.

File Exchange 
Space

Small shared space for users to store project files. Separate 
spaces exist for users connecting through SMB and AFP, files 
are not owned by any specific user, and files cannot be 
protected. Media files are not permitted.

See "File Exchange 
Spaces" on page 76.

Shared Project 
Space

Space to store shared projects. Media files are not permitted. See "Sharing Avid 
Projects Using 
Avid Shared 
Project Spaces" on 
page 81 and 
"Sharing Final Cut 
Pro 6 and 7 
Projects" on page 
134

Type of Space
Space 

Subtype Description
For more 

information
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EditShare Administrator

The EditShare Administrator takes responsibility for the daily operation and 
configuration of an EditShare server. In some organizations this is a system 
administrator or technical support specialist, while in others it is an editor who 
takes on this additional role. The EditShare Administrator has the following 
responsibilities:

• Set up and configure the EditShare server and network (or help the reseller 
to do so), following the detailed instructions in the EditShare 
Administrator’s Guide.

• Create user accounts on the EditShare system and provide editors with the 
usernames and passwords they are to use. (See chapters 6-8 of the 
EditShare Administrator’s Guide.) Some users might be granted limited 
administrative capabilities. For example, a lead editor on a particular 
project might be allowed to manage the media for that project.

• Create Media Spaces for storing media files, typically one or more Media 
Spaces for each project. (See chapters 10-12 of the EditShare 
Administrator’s Guide.) 

• Oversee management of media on the EditShare server by ensuring that 
media is protected when it should be and coordinating times when media 
is organized or deleted.

• Provide a first line of support for other editors in the organization, helping 
them to learn the EditShare system and attempting to resolve problems 
locally before calling your dealer or EditShare Technical Support.

EditShare Workflows

Different organizations naturally use different workflows. The following is a 
general overview of how you use the EditShare system to store media files and 
projects and share them among multiple editors. You might find that the system 
at your organization is not exactly like this, but it should be similar.

When you begin working, you run EditShare Connect on your workstation to 
log in to EditShare, being careful to confirm that no one else is logged in at the 
same time with the same username. This gives you access to all the Spaces that 
have been created by the Administrator. (For more information about each type 
of media space, see "Chapter 4: Media Spaces" on page 36.) You mount the 
Spaces you intend to work with through EditShare Connect and start your NLE.
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See the following topics:

• "Avid Editors – Shared Project and Media Workflow" on page 14

• "Final Cut Pro 6 and 7 and Adobe Premiere Pro Editors – Shared Projects 
Workflow" on page 15

• "Final Cut Pro X – Shared Projects Workflow" on page 16

• "Final Cut Pro, Adobe Premiere Pro, and Other NLE Editors – Individual 
Projects Workflow" on page 16

Avid Editors – Shared Project and Media Workflow

As an Avid editor, in all likelihood you are working either with Avid Style 
Spaces (where you can put both projects and media) or with a combination of 
Avid Shared Project Spaces (for shared projects) and Avid MXF Spaces (for 
media). The different types of spaces each have their pros and cons. Whichever 
spaces your EditShare Administrator has chosen, you can share both media and 
projects with your colleagues and have a complete collaborative workflow. 

After you start EditShare Connect and mount the spaces you intend to use, on 
Mac OS X you can start Avid as usual (see “Chapter 3: Getting Started as an 
Editor” on page 19). On Windows workstations you will probably start Avid 
using EditShare’s Avid Launcher on the Avid Management tab of EditShare 
Connect. See “Using Avid Launcher” on page 49 for more information about 
when and how to use the Avid.

When you’re ready to capture media, you tell Avid to store its captured media 
in an Avid MXF or Avid Style Media Space instead of on a local hard drive, and 
you log it into a bin where you have Read/Write access. 

In Avid Style Spaces, (which function essentially the same as Avid Unity and 
ISIS workspaces), the first person who opens a bin gets Read/Write access and 
all subsequent users are restricted to Read Only access until the bin is closed by 
that first user. Then the next user to open it gets Read/Write Access. While you 
have a bin locked, other users can still open that bin and see the contents as you 
last saved it. They can easily copy clips and sequences out of your locked bin and 
use them in their own sequences that they are saving in a bin where they have 
Read/Write access. In general, all media in Avid Style spaces can always be 
deleted by any user who has overall write access to the space. If you delete clips 
in a bin that is Read Only to you at the moment, you do not delete the master 
clips from the bin. You can, however, delete the actual media files from the 
space. 

The rules governing EditShare’s Avid Shared Project Spaces are a little different. 
In each shared Avid Project, every user gets his or her own User Folder. While 
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a bin resides in your own User Folder, only you have Read/Write access to the 
bin. Other users can see the contents of your bin as you last saved it. They can 
open the clips and sequences from there, play them, and edit them into their 
own sequences which they can save in their own bins. They can also copy your 
entire sequence and save a copy in their own bin. However, other users cannot 
modify your bin, even when you don’t have the bin open. 

EditShare provides a way to pass the ownership of bins from one user to 
another, but generally you have to initiate giving up control of your bin before 
another user can take control. In a similar manner, when you capture or render 
media into an Avid MXF Media Space, generally the files you create can only be 
deleted by you, unless the Administrator puts the space into Maintenance Mode 
and gives control to another user, or unless the Administrator protects your files 
so that even you don’t have the ability to delete them. 

While the two systems differ in their security rules, they both achieve the same 
end result – allowing a group of editors to work collaboratively sharing the same 
media and project files. 

For detailed information, see the following topics:

• "Introduction to Avid Style and Avid MXF Media Spaces" on page 39

• "Spaces for Storing and Sharing Avid Projects" on page 77

• "Avid Style Workflow" on page 80

• "Chapter 7: Important Things to Know When Using EditShare with Avid" 
on page 104

Final Cut Pro 6 and 7 and Adobe Premiere Pro Editors – Shared Projects Workflow

As a Final Cut Pro 6 and 7 or Adobe Premiere Pro editor, you are very likely 
working with a Final Cut Shared Project or an Adobe Premiere Pro Shared 
Project, or with a lockable project space. Once you have started EditShare 
Connect and mounted the Media and Project Spaces you intend to use, you can 
start your editing application as usual, along with the EditShare Project Browser 
(see "Chapter 3: Getting Started as an Editor" on page 19).

When you’re ready to capture media, you create a new Final Cut Project file or 
Adobe Premiere Pro Project file in the project structure in the Shared Project 
Space. You set Final Cut’s Capture Scratch directory to a Managed Media Space 
or an Unmanaged Media Space instead of a folder on a local hard drive, and you 
log it into a bin in your own project file. Other users can open your project and 
see the clips you capture as soon as you save the project. They can edit your clips 
into their sequences, but they cannot modify or delete them – only you can do 
that. You can also look at the clips other users have captured, and the sequences 
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they’ve cut, by looking in the project files stored in their user folders. To work 
on another user’s sequence, you make a copy of the sequence in one of your own 
project files first, then edit it there – you cannot modify anything in another 
user's project file, just as no one else can modify anything in your project files.

The EditShare Administrator (or a designated user) might protect the media 
you’ve captured, to guard against accidentally deleting it after other editors have 
cut it into their sequences. 

For more information, see "Project Sharing with Final Cut Pro 6 and 7, Adobe 
Premiere Pro, and Other NLEs" on page 85 and "Chapter 8: Using EditShare 
with Final Cut Pro 6 and 7" on page 131.

Final Cut Pro X – Shared Projects Workflow

If you are working with FCP-X, you can store your Project Files (Events and 
Projects) on EditShare Unmanaged Media Spaces. You can also share media 
files with colleagues who have their own Project Files. You cannot currently 
share the actual FCP-X projects because of the structure of those projects and 
the fact that they cannot be opened Read Only. However, by exchanging XML 
exports of Final Cut Pro Events and Projects, you can achieve a shared project 
workflow with FCP-X.

For more information about working with FCP X, see "Chapter 9: Using 
EditShare with Final Cut Pro X" on page 145.

Final Cut Pro, Adobe Premiere Pro, and Other NLE Editors – Individual  
Projects Workflow

As an editor using Final Cut Pro to work on a standalone project, or if you use 
another NLE system such as Adobe Premiere Pro, you keep your own copy of 
the project on your hard drive or in your Private Files Space on the EditShare 
server. 

When you’re ready to capture media, you tell your NLE to store its captured 
media in a Managed Media Space or an Unmanaged Media Space instead of on 
a local hard drive. You can rename, move, modify, or delete the files you 
captured, but no one else can. Other users can see your captured media 
immediately and import it into their project – or, to help keep media organized, 
you might export a copy of the bin you captured into and save it in the Shared 
Project Files folder on the EditShare server for other users to import. They can 
then incorporate the captured media into their sequences. 
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The EditShare Administrator (or a designated user) might protect the media 
you’ve captured, to guard against accidentally deleting it after other editors have 
cut it into their sequences.

For more information, see "Chapter 8: Using EditShare with Final Cut Pro 6 and 
7" on page 131, "Chapter 10: Using EditShare with Adobe Premiere Pro" on page 
152, and "Chapter 11: Using EditShare with Other NLEs" on page 158.

Metadata and Media Files

Non-linear editing projects primarily use two types of files: media files and 
metadata files. In order to use EditShare safely and effectively, you need to 
understand the differences between them. These differences require you to use 
somewhat different strategies for sharing them.

See the following topics:

• "Media Files" on page 17

• "Metadata Files" on page 17

• "Other Files" on page 18

• "Why Sharing Metadata is Different from Sharing Media Files" on page 18

Media Files

Media files are your captured or rendered video and audio files. The essential 
fact about media files is that, once they have been captured, they are ordinarily 
not modified. When you edit with an NLE, the software does not modify 
existing media files – it simply refers to sections of specific files.

Metadata Files

Metadata files are everything media files are not. Depending on your NLE, 
metadata might include project files, bins, sequences, and settings files. 
Metadata files are frequently changed during the course of editing.
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Other Files

Some files are not clearly media or metadata. For example, still images, title 
graphics, text files, and credit rolls are media but might be modified outside of 
the NLE. You should generally treat such files as if they were metadata.

Why Sharing Metadata is Different from Sharing Media Files

Most editing applications such as Avid Media Composer, Final Cut Pro, and 
Adobe Premiere Pro have no built-in capability to referee what happens if 
multiple users open and try to modify the same metadata file at once. 

For example, if Editor A makes a change in a sequence and Editor B has the 
same sequence file open, when Editor B saves the sequence, he overwrites all the 
changes that had been made by Editor A. 

Similarly, if Editor B adds two clips to a bin, and Editor C adds two different 
clips to the same bin, the last editor to save the bin is the one whose data is 
retained. The other editor’s data might get lost. 

Because of such issues, it is generally not safe to simultaneously open the same 
metadata files from more than one workstation if it is possible that one or both 
users might wish to modify the files. 

Media files are typically not modified once they are created, so it is generally safe 
for multiple editors to open and view the same media files at once. But project 
files (metadata) are modified almost every time they are opened – even as simple 
an action as moving the play head on a clip usually results in a change to a 
project file. In order to collaborate on a project, each editor must usually work 
with his or her own copy of the metadata files. 

The EditShare system, however, allows multiple users to share project files in 
spaces that can be used with most NLEs, including Avid Media Composer, Final 
Cut Pro, and Adobe Premiere Pro. If your project is stored and shared in a 
Shared Project Space or an Avid Style space, you can safely work with projects, 
bins, and sequences that other users are working on. The EditShare system 
allows multiple users to have safe, read-only access to project files while 
ensuring that only one user at a time can write to these files. You can read more 
about this feature in “Avid Style Media Spaces in Detail” on page 42, “Spaces for 
Storing and Sharing Avid Projects” on page 77, "Chapter 7: Important Things to 
Know When Using EditShare with Avid" on page 104, and "Chapter 8: Using 
EditShare with Final Cut Pro 6 and 7" on page 131.

If you do not use EditShare’s project-sharing feature, you can still collaborate on 
projects by having each editor work with his or her own copy of the metadata 
files. Methods for doing this are discussed in the following chapters. 



Chapter 3: Getting Started as an Editor

This chapter describes the procedures you follow as an editor to work on 
projects using EditShare. You follow these procedures regardless of which NLE 
you use. Additional information specific to Avid products, Final Cut Pro, 
Adobe Premiere Pro, and other NLEs can be found in the chapters for those 
systems. These chapters contain many important procedures that you must 
follow to avoid damaging your data.

For general information on working with projects in EditShare, see the 
following topics:

• Administrator Responsibilities

• Preparing OS X Workstations (Macintosh Only)

• Logging in with EditShare Connect

• Connecting to Spaces

• Managing Connections to Spaces

• Connecting to EditShare Spaces by NFS – Linux Users Only

• Migrating Media and Projects to EditShare

• Troubleshooting EditShare Connect

Administrator Responsibilities

Before you use EditShare, your Administrator must do the following:

• Set up the EditShare server.

• Install the EditShare Connect software on your workstation.

• (OS X only) EditShare supports connecting from Mac OS X workstations 
by either the AFP or SMB network protocols. If editors will be connecting 
by SMB, it is highly recommended that you install the third party DAVE 
network client on all of your workstations rather than using the Native 
SMB client that is included with Mac OS X. For more information, see 
“Using AFP or DAVE (Macintosh Only)” on page 116.  This section 
explains when it's okay to use AFP (generally preferred) and when you 
should use DAVE. Using the Native SMB client is highly discouraged.
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The Administrator should also provide you with the following information:

• The IP address of the EditShare Master server. In some environments, 
different workstations might use different IP addresses to contact the 
master server. Always use the proper IP address for the workstation from 
which you are connecting.

• A username and password. It is important that no user is ever connected 
to the EditShare server twice at the same time – for example, from two 
different workstations. If you need to work on more than one workstation 
at a time, the EditShare Administrator should provide you with more than 
one username. In some environments, usernames to log in with might be 
allocated for each workstation rather than each editor.

• One or more Media Spaces to use for your projects. If your project uses 
more than one Media Space (as most do), be sure to find out how they are 
to be used. For example, you might be given one Media Space for 
capturing media and a separate Media Space for rendered files, or there 
might be several Media Spaces into which different types of media should 
be captured.

• If you are working on a Macintosh workstation, your Administrator 
determines what network protocol (DAVE SMB, Native SMB, or AFP) 
you need to use to mount each Media Space:

– AFP is the default protocol used by Mac OS X to access networked 
storage.

– Native SMB is the Windows Networking client built into Mac OS X.

– DAVE SMB is a third-party replacement Windows Networking 
client that offers much better performance and reliability than the 
Native SMB client built into Mac OS X.

If you choose SMB, all workstations must use the same type of SMB: either 
DAVE SMB (recommended) or Native SMB. Mixing access by DAVE SMB 
and Native SMB can cause many issues. For more information about 
network protocols and DAVE , see the EditShare Administrator’s Guide.

Preparing OS X Workstations (Macintosh Only)

When you use Mac OS X, you need to make a few minor changes to the Finder 
preferences to help you quickly access EditShare Spaces.

NOTE:  EditShare supports only version 10.6 and later.
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By default, OS X does not display Connected Servers on the Desktop or 
Connected Volumes on the Finder window sidebar, and new Finder windows 
default to displaying your Home folder.

To configure the Finder preferences, do the following.

TASK

1. Select Finder > Preferences.

 The Finder Preferences window opens. 

2. In the “Show these items on the desktop” list, select “Connected servers.”

3. From the “New Finder windows open” list, select your computer.
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4. Click the Sidebar tab.

 

5. In the Devices area, select your computer.

6. In the Shared area, select Connected Servers.

7. Close the Finder Preferences window.

8. In the Finder, drag the desktop icon for the EditShare volume to the Devices 
section at the top of the Finder sidebar.

 The network volumes you use most often are available at the top of the 
sidebar and all mounted volumes are displayed in the first view of new Finder 
windows.

NOTE:  Do not try to connect to the EditShare server by clicking its address in the 
sidebar. If you do, the server reports “Connection Failed.”

Logging in with EditShare Connect

EditShare Connect is an application that runs on your Windows or OS X 
workstation and allows you to connect to any space on any of your EditShare 
servers from one simple interface, and (on Windows) to map it to a drive letter. 
It then remembers which Media Space, Project Space, or other spaces you are 
connected to (and to what drive letters they are mapped) the next time you log 
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in, even from a different workstation, and automatically reconnects you to the 
same spaces. For designated users, EditShare Connect also provides limited 
access to the management functions of EditShare.

See the EditShare Administrator's Guide for instructions on installing EditShare 
Connect on editors’ workstations.

CAUTION:  Do not connect to EditShare from more than one workstation at a time with 
the same username. This can corrupt your data. If you need to change workstations, 
always log out of EditShare on one workstation before you log in on another one. 

To log in with EditShare Connect:

TASK

1. Determine the IP address of the Master server port to which your workstation 
is connected.

2. In Windows, click the Start button, then select Programs > EditShare > 
EditShare Connect. On OS X, open EditShare Connect from the Dock or 
Applications folder.

 The Login to EditShare dialog box opens.

3. Type the IP address of the your workstations’s Master server in the Address 
text box.

 The IP address is remembered and filled in automatically the next time you 
start EditShare Connect.

4. (Option) Select Remember Me for your username and password to be 
remembered and filled in automatically the next time you log in. If your 
workstation is used by multiple people, do not select this option, as it may 
allow others to log in with your credentials. 
If you are logging in with an Active Directory account, check that box as well.
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5. Type your username and password in the text boxes and click Login.

 NOTE:  You can change your password after you log in. See "Changing Your 
EditShare Connect Password" on page 25.

EditShare Connect opens.

NOTE:  If no Spaces appear in the EditShare Connect window, the network might 
have been configured incorrectly and might be trying to use Jumbo Frames on a 
network that does not support them. For more information, see “Network 
Configuration” in the EditShare Administrator’s Guide.

Resetting Your Login Count

If you try to log into EditShare Connect while you are already logged into any 
other workstations, EditShare Connect will warn you before you log in. 
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If you see this message because your account is active on more than one 
workstation, EditShare strongly recommends that you click Cancel and log in as 
a different user. 

If you see this message because your workstation crashed, and you are 
absolutely certain that no other workstations are logged in as this user, you can 
click “Clear count and Log in” to reset this count, prevent this message from 
appearing again, and continue to log into EditShare Connect.

Changing Your EditShare Connect Password

You can change your EditShare Connect password unless you are using Active 
Directory authentication. (For more information about Active Directory 
support, see the EditShare Administrator’s Guide.) After you change your 
password, you are logged out of EditShare Connect and need to log in again:

TASK

1. Save all your files and close any editing applications.

2. Log into EditShare Connect.

3. Click the Settings tab, then click the Password Change tab on the left.

 The Change Login Password dialog opens.
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4. Type your current password in the Old Password text box.

5. Type your new password in the New Password text box, and then type it again 
in the Confirm Password text box.

6. Click Change.

 You are logged out of EditShare Connect.

Connecting to Spaces

Much of the EditShare Connect window shows you the EditShare Spaces 
available to you. You can also click the triangular toggle at the right side of each 
group to minimize it, leaving more room for the other groups.
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OS X users need to select the network protocol that will be used to mount the 
space. 

To mount a space:
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TASK

1. Do one of the following: 
• (Windows) Select a drive letter for the space from the Mount column.

• (OS X) EditShare Spaces can be mounted by AFP or SMB, depending on 
the network protocol that was chosen by the EditShare Administrator 
when the Space was created. Your administrator might choose to mix 
protocols — that is, configure some Spaces to be mounted by AFP and 
others by SMB. Or your administrator might configure all Spaces to be 
mounted by the same consistent protocol. Both approaches are valid. If 
your Administrator chooses SMB for a Space, the mount option appears 
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as DAVE SMB or Native SMB, depending on whether you have DAVE 
installed or not.

2. (Optional) To disconnect from the Space, select the blank option from the top 
of the list in the Mount column.

Managing Connections to Spaces

• "Disconnecting or Unmounting All Spaces" on page 29

• "Working with EditShare Spaces" on page 30

• "Hiding Mac Resource Forks" on page 30

• "Quitting EditShare Connect" on page 30

Disconnecting or Unmounting All Spaces

To unmount all currently mounted Spaces, you can close the NLE and quit 
EditShare Connect. You can also unmount all Spaces without closing EditShare 
Connect by clicking the Unmount All button in the Spaces tab.

CAUTION:  Do not mount or unmount media spaces using OS X Finder or Windows 
Explorer. If you do, EditShare Connect may not properly notice when spaces are 
unmounted, and it might be difficult to remount the drive.
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Working with EditShare Spaces

EditShare Connect also provides access to management functions for EditShare 
Spaces, such as QuickTime Reference Mode, as well as Limited Administrative 
capabilities for authorized users.

For more information, see "Making QuickTime Movies with QuickTime 
Reference Mode" on page 57.

Hiding Mac Resource Forks

You can hide Mac resource fork files on Windows machines. The presence of 
Mac resource forks in Media and Project Spaces has been reported to cause 
issues for some Windows applications, particularly for Avid Media Composer 
v6 where the Avid Phrase Find plug-in can hang if it sees the Mac resource fork 
files. 

To resolve this issue, on Windows EditShare Connect you can select Options > 
Hide Mac Resource Forks. You should not select Hide Mac Resource Forks 
unless you use a mixture of Windows and Mac Avid applications at your site, 
and unless those applications share the same spaces.  

Quitting EditShare Connect

When you quit EditShare Connect, all of your Media Spaces, Project Spaces, and 
other spaces are disconnected. Other users can now use that workstation to 
connect to their spaces, and you can safely log in on another workstation. 

To quit EditShare Connect:
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TASK

1. Click the Quit button at the bottom right of the window. If any spaces are in 
use, you are asked if you want to force them to unmount, to leave the drives 
connected, or to stop logging out. 
• To stop logging out, click Cancel. Find the application that has files 

open, close them, and then repeat Step 1.

• To log out of EditShare Connect and leave the connected spaces 
mounted, click No. 

NOTE:  EditShare Connect may encounter issues if you or another user attempt to 
mount the connected spaces again. EditShare recommends unmounting the spaces 
through the operating system when you are finished working with them.

• To forcibly unmount any connected spaces, click Force Unmount.

NOTE:  Forcibly unmounting spaces that are in use by an application can result in 
data loss or corruption.

2. Do one of the following:

 Your Spaces are disconnected, and your drive mappings are saved. 

NOTE:  Do not use other methods of exiting EditShare Connect, such as the Force 
Quit action in OS X. This does not log you out of the server properly and might 
cause problems when you or another user try to log in again on that workstation.

Connecting to EditShare Spaces by NFS – Linux Users Only

EditShare allows Linux users to access Media Spaces and Project Spaces via the 
Network File System (NFS) protocol. EditShare's NFS support is specifically 
aimed at Linux users. Although Linux users can also access EditShare spaces via 
the CIFS or SMB protocols (using mount.cifs or mount -t smbfs commands) 
and although CIFS or SMB might be adequate for occasional copying of data, 
performance is far superior when you access EditShare spaces via NFS.

If your EditShare Administrator has allowed you to mount one or more Spaces 
by NFS, the NFS Export Tool on the server generates a file called nfs-exports.txt 
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in the SMB File Exchange. This file includes command line instructions about 
how to mount the spaces from your Linux workstation, as shown in the 
following illustration.

NOTE:  While Mac OS X and Windows 7 and later also include native support for NFS, 
performance and NLE compatibility is much better when you use AFP on Mac OS X and 
when you use SMB on Windows. If you are working from a Mac OS X or Windows 
workstation, do not use NFS to access your EditShare storage. 

Migrating Media and Projects to EditShare

You can migrate your existing media and projects to EditShare. You should first 
do the following:

1) Select projects that are active editing assignments.

2) Organize the media in terms of the project it belongs to. Keep projects 
separate that are owned by different clients, or projects covering different 
subject matter. This facilitates editors knowing which Media Spaces to 
mount, which media can be moved or deleted, and where the media 
resides.

3) Decide on a schema: post-production houses might create a Media Space 
for each job, while a news facility might organize by dates or subject 
matter, for example, features, interviews, headlines, and so on.

4) Create the Media Spaces you need.
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See the following topics:

• "Migrating Avid Media and Projects to EditShare" on page 127

• "Migrating Final Cut Pro 6 and 7 Media and Projects to EditShare" on page 
137

Troubleshooting EditShare Connect

The following table includes possible solutions to common problems you might 
encounter while using EditShare Connect.

Problem Possible Solution

Error message when you log 
in

• Check the server IP address.
• Make sure the server is running and on the network.
• Check your username and password.

No Spaces visible after you 
log in

• Make sure the Master server and all Expansion servers are running and on the network.
• Try disabling Jumbo Frames on your workstation if they are enabled. If that works, your 

network might not properly support Jumbo Frames.
• You might not be a member of any Media Space.

Settings forgotten when you 
log out

• Make sure you’ve selected the correct profile.

Cannot exit the application • Click the Quit button at the bottom right of the EditShare Connect window.

Drives stay connected after 
you log out

• Make sure no application (including your editing application) has a project or document 
on the drive open when you quit.

• Log out by clicking the Quit button at the bottom right of the EditShare Connect window.
• Drives connected outside EditShare Connect are not disconnected by EditShare 

Connect.

Error message when you 
connect to Spaces

• You cannot connect to a Space to which you are already connected.
• (Windows only) You might have another Space or drive mapped to the selected letter. 

Try a different letter.
• The Space might have been removed or your access might have been removed.
• You cannot be logged into a server as two different users at the same time. Check to see 

if you might have a drive mounted as a different user. Logging out of the operating system 
might help.
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Checking the EditShare Server Status from EditShare Connect

Editors can see the EditShare server status in EditShare Connect’s server status 
indicator, located at the top right of the EditShare Connect interface.

If the status is “Good,” the server is functioning normally and is not reporting 
any issues.

If the stauts is “Warning,” a temporary or non-critical problem is affecting the 
server, reducing performance or preventing certain functions from working. 
For instance, there may be a connection error:

Or there may be a hardware issue, which should be immediately reported to 
your EditShare administrator:

If the status is “Error,” something is preventing the workstation from reaching 
one or more of the EditShare servers. The server may be off, certain services may 
not be working, or there may be a network error preventing access.

Some Spaces are not shown • Spaces to which you do not have access are not shown.
• Spaces on servers that are not operating or not on the network are not shown.
• You might be logged in as a different user.

Problem Possible Solution
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You can click the server status to see more details.

If the EditShare server has recently been updated, the checkmark next to the 
Good status indicator may change:

To download the update, access the server’s status page by entering the server’s 
IP address in your workstation’s web browser and clicking the Clients link, or 
quit EditShare Connect, then re-open it. After you log in, you should see a 
message indicating that an updated version of EditShare Connect is available.

Click Download Update to access a web page with the updated installer. You 
may need dministrative access to your workstation to install the update.

NOTE:  Always make sure EditShare Connect is updated after your administrator updates 
the server. Some features may not work if the EditShare Connect client is out of date.
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Media Spaces are virtual volumes on the EditShare server where your media 
files are stored and shared. You need to create at least one Media Space for 
storing media files.

See the following topics:

• Using Multiple Media Spaces

• Controlling Access to Media Spaces

• Protecting Media in Media Spaces

• Types of Media Spaces

• Introduction to Avid Style and Avid MXF Media Spaces

• Avid Style Media Spaces in Detail

• Avid MXF Media Spaces in Detail

• Managed Media Spaces

• Universal Media Spaces

• Unmanaged Media Spaces

• EditShare Connect Profiles

Using Multiple Media Spaces

Your EditShare Administrator is responsible for creating the Media Spaces of 
the proper types for your organization, specifying which users can access each 
Media Space, and deciding whether to set a quota on each Media Space to limit 
the total size of files that can be stored in that Space.

The best way to manage media is to give each new project its own Media Space, 
with the same name as the project. This way you know exactly where the media 
is stored that belongs to a particular project, making it easy to manage – and 
eventually delete – the media from one project without affecting the media from 
another project. Knowing that all the media in a particular Media Space can be 
deleted vastly simplifies media management. In some cases, you might even 
prefer to use multiple Media Spaces for an individual project, to help keep your 
media files better organized or to optimize the use of your EditShare storage. 
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Consider the following:

• EditShare highly recommends having separate Media Spaces for rendered 
files and for original media.

• For an ongoing TV program like a news show, you might have Media 
Spaces for each week of shooting, so old media can easily be deleted 
without affecting newer work.

• To more evenly distribute media across the storage devices, you might 
have separate Media Spaces for different cameras. You might capture 
footage from Camera 1 to one Media Space, from Camera 2 to a second, 
and so on. 

 The EditShare Administrator's Guide has more information about how to set up 
Media Spaces. As an editor, make sure you find out from your EditShare 
Administrator which Media Spaces to use for which purposes.

Controlling Access to Media Spaces

When a Media Space is created, users must be added to the Space in order to 
have access to it. Only users who have been added to the Media Space can 
connect to it over the network or see any of the media in it. The EditShare 
Administrator (or a user to whom the Administrator has delegated this 
authority) can add or remove users to a Media Space at any time.

By default, a user added to a Media Space has full read/write access to the Space. 
However, the Administrator (or designated user) can restrict specified users to 
read-only access to a Media Space. A user with read-only access to a Media 
Space cannot capture or render files into it. All other users still have read/write 
access to that Media Space, and the user still has read/write access to any other 
Media Spaces of which he or she is a member.

Protecting Media in Media Spaces

Although a Media Space is used just like any shared networked drive, it is much 
more complex. On a typical (that is, non-EditShare) networked drive, all users 
looking at the drive see the same contents, and any user can add, change, or 
delete files at any time. Indeed, an EditShare Unmanaged Media Space works 
just this way, for those users who want that. 
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However, this can be problematic in a shared environment. For example, one 
user might believe a particular file is unneeded and delete it, unaware that 
another user still needs it. Worse, some NLEs (notably Avid) might cause 
serious data corruption if multiple editors try to work with the same drive at the 
same time.

EditShare Media Spaces, on the other hand, are designed to allow multiple 
editors to share media safely. This enables editors to work with the same media 
at the same time without confusing the NLE software. It also helps to protect 
against the possibility of one editor accidentally or maliciously deleting, 
modifying, or overwriting media that another user is relying on. 

Different types of Media Spaces provide these protections differently. Each type 
has its own advantages and disadvantages. To provide this protection, EditShare 
requires a specific procedure to be followed in order to delete, modify, or 
overwrite data in a Media Space. 

Types of Media Spaces

EditShare supports several types of Media Spaces, each offering support for 
specific types of NLEs and a different method of managing media (and, in some 
cases, also projects). The types include the following:

• Avid Style spaces (for Avid users only); see "Introduction to Avid Style and 
Avid MXF Media Spaces" on page 39 and “Avid Style Media Spaces in 
Detail” on page 42

• Avid MXF spaces (for Avid users only); see "Avid MXF Media Spaces in 
Detail" on page 51

• Managed (for all NLEs except Avid, such as Final Cut Pro or Adobe 
Premiere Pro); see "Managed Media Spaces" on page 62

• Unmanaged (for all NLEs except Avid, as well as non-project metadata 
and other media or asset files); see "Unmanaged Media Spaces" on page 67

• Universal (for use with EditShare Flow); see your Flow documentation

Your Administrator can also make any Media Space Public, which provides 
access to all users. See the EditShare Administrator’s Guide.

NOTE:  If your server was upgraded from an older version of EditShare, or in very specific 
legacy Avid workflows, you may also have access to Traditional Media Spaces. For more 
information, see "Appendix A: Traditional Media Spaces" on page 163.
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Introduction to Avid Style and Avid MXF Media Spaces

If you work with Avid Media Composer or Avid Symphony, as well as older 
Avid applications such as Avid NewsCutter, Xpress Pro, and Xpress DV, you 
can store your media files in either Avid Style or Avid MXF Media Spaces. In 
addition, you can store your Avid project files (bins and sequences) in either 
Avid Style Media Spaces or Avid Shared Project Spaces (see “Spaces for Storing 
and Sharing Avid Projects” on page 77 for more information about Avid Project 
Sharing). Which specific types of spaces you use depends on your workflow 
preferences and needs. 

While EditShare pioneered the first non-Avid system for sharing media, bins, 
and sequences (a system that includes EditShare’s patented Avid MXF Spaces 
and Shared Avid Project Spaces), EditShare’s Avid Style sharing provides 
bin-locking and media sharing that works the same way as Avid's Unity and ISIS 
storage.

Each type of space and its associated workflow has advantages and 
disadvantages. For example, the original EditShare way of sharing bins – in Avid 
Shared Project Spaces – is much more secure for schools and organizations, 
where individual editors want some guarantee that their shared bins and 
sequences cannot be modified by others. Similarly, with Avid MXF spaces, 
media files are controlled by the user (not the workstation) that created them. 
Also, rebuilding media database files is easier with EditShare's Avid MXF spaces 
compared to Avid Style spaces.

The following illustrations show the structure of EditShare’s Avid MXF spaces 
and Avid Shared Project spaces.

With Avid MXF spaces, each editor has his or her own view of the Media Space. 
UserB’s media is stored in a 1 or 2 folder (and so on). UserB sees UserA’s media 
in folders called UserA_1 and UserA_2. 
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In EditShare’s Avid Shared Project spaces, control over shared bins in an Avid 
Project, as seen in the previous illustration, is managed according to the user 
folder where the bins reside. Bins in UserA’s folder are Read Only to other users. 
UserA has read-only access to UserB’s and UserC’s bins. Using Avid MXF and 
Shared Avid Project spaces is very effective for collaborative workflows.

However, if you are an Avid editor accustomed to the way Avid Unity and Avid 
ISIS storage work, with EditShare's Avid Style sharing you do not need to learn 
a new way of doing things; you get both Avid Style bin-locking and the Avid way 
of managing media files according to the workstation that created the media. In 
addition, with Avid Style Spaces, you get a small performance boost that can be 
important when you ingest or output sequences with many layers of audio and 
video tracks.

With Avid Style spaces, media is stored in folders that correspond to the name 
of the workstation where the media was created. For example, in the following 
illustration, three workstations—editbay1, editbay2, and editbay3—have put 
media into this Avid Style space.

If you move from one workstation to another, it can be more complicated for 
you to maintain absolute control over your media with Avid Style spaces 
because control over the media database files stays with the workstations.
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For Avid projects stored in Avid Style Media Spaces, there is no locking of bins 
by users as seen in the following illustration. Any bin can be opened Read-Write 
by the first user who opens it. This is represented in the Avid application by a 
green lock icon on the bin. Any subsequent users have only Read access, which 
is represented by a red lock icon.

With EditShare, you are not forced into using only one approach. For example, 
you can use Avid MXF Media Spaces for your media and Avid Style Media 
Spaces for your bins, or equally viable, you can use Avid Style Spaces for your 
media and Shared Avid Project Spaces for your bins and sequences. 

For important information on where to save your Avid projects, see “Backing 
up Avid Projects” on page 41.

Backing up Avid Projects

EditShare servers are configured by default to automatically backup your shared 
Avid projects daily at 4 a.m. server time.  The backup includes all Avid projects 
located in any Shared Avid Project Space, as well as all Avid projects stored in 
any Avid Style Space. 

For the backup feature to work with Avid Style spaces, you must save your Avid 
projects inside the Avid Projects directory that EditShare makes whenever a 
new Avid Style space is created. Avid projects stored outside this directory are 
not backed up. The following screen shots illustrate where you must save your 
Avid projects inside Avid Style spaces so that they will get backed up each night.
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Avid Style Media Spaces in Detail

The following table describes features of Avid Style Media Spaces.

Feature Description

Supported NLE Avid v5.x and later. You can use Avid Style Spaces for either MXF or OMF video media, and 
MXF (PCM), AIF, or WAVE audio.

NOTE:  You can use Avid Media Composer v2.8 and later. However, EditShare tests compat-
ibility with only v5 and later.

Network Protocol Windows: SMB/CIFS; Mac: DAVE SMB or AFP
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Although media and projects can be stored in a single Avid Style Media Space, 
EditShare recommends creating a dedicated Avid Style Media Space just for 
Avid projects. It makes sense to call this Space Avid Projects.

For information about setting up an Avid Style space, see the following topics:

• “Setting up Avid Style on a Mac OS X System” on page 43

• “Optimizing Avid Style Spaces on a Mac OS X System” on page 45

• “Setting up Avid Style Spaces on a Windows System” on page 46

• “Installing and Configuring EditShare Connect for Windows” on page 47

• “Using Avid Launcher” on page 49

Setting up Avid Style on a Mac OS X System

To set up Avid Style on a Mac OS X system, the Avid application cannot be 
running. You also need to have Administrator privileges on the workstation so 
EditShare can make some small permissions changes. 

Access Control Users must be added to the Media Space to have access. However, unlike with Avid MXF 
Spaces, media is written into directories that correspond with the name of the computer 
that is connecting to the space, not written into user directories. 
All media is read-write to all users who have read-write access to the space. 
Any user can delete media from any media folder in the Space. 
The same holds true for the bins in any projects that are stored in the Space.

User Operations You must enable EditShare Avid support in your EditShare Connect client to use Avid Style 
Spaces. If EditShare Avid support is not enabled, you cannot capture media into the Space 
You can switch support on and off by selecting or deselecting the EditShare Avid option.

Contents OMFI MediaFiles/Creating (folder present but unwritable to all users) 
OMFI Media Files/YourComputerName (folder where your workstation writes OMF files 
when running Avid) 
OMFI Media Files/OtherComputerNames (folders where other workstations write OMF 
files when running Avid) 
Avid MediaFiles/MXF/1 (folder present but unwritable to all users) 
Avid MediaFiles/MXF/YourComputerName.1 (folder where your workstation writes MXF 
files when running Avid) 
Avid MediaFiles/MXF/YourComputerName.# (additional folder where your workstation 
writes MXF files when running Avid) 
Avid MediaFiles/MXF/OtherComputerNames.# (folders where other workstations write 
MXF files when running Avid) 
AvidProjects/ (folder where you should store Avid projects if you want Avid Style locking)

Feature Description
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To set up Avid Style, do the following.

TASK

1. Make sure your Avid application is not running.

2. Start EditShare Connect and login.

3. Click the Settings tab, then click the Avid Style & Avid AFP tab on the left side.

4. Click the Enable Avid Style and Avid AFP option.

 

A dialog box may open saying that you need Administrator permission. If so, 
click OK and enter your Administrator username and password.

5. Start Avid and create a new project in an Avid Style Media Space.

6. Open a new bin and make sure the green Lock icon displays.

 

You are ready to use Avid Style Media Spaces on your Mac.

NOTE:  If you upgrade your Avid software, you need to repeat Steps 1-7 the first 
time you start EditShare Connect.
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Optimizing Avid Style Spaces on a Mac OS X System

Avid Media Composer & 
ESC Avid Style Version

DAVE SMB support 
for Shared Projects

DAVE SMB support 
for Shared Media

AFP support for 
Shared Projects

AFP support for 
Shared Media

Support for 
AAF Exports*

Media Composer 2.8-3.5.x 
Legacy Avid Style**  

Media Composer 4.0.x 
Legacy Avid Style (default)    
Media Composer 4.0.x 
New Avid Style    

Media Composer 5.0.x 
Legacy Avid Style    
Media Composer 5.0.x 
New Avid Style (default)    

Media Composer 5.5.x 
Legacy Avid Style   
Media Composer 5.5.x 
New Avid Style (default)     

Media Composer 6.x and 
later 
New Avid Style**     

EditShare ships several different versions of its Avid Style code in order to 
support all 32-bit and 64-bit versions of Avid — from the most recent Media 
Composer v7 all the way back to Media Composer v2.8 (this includes the 
corresponding versions of Symphony, NewsCutter, and Xpress Pro). EditShare 
Connect automatically uses the Avid Style version that is most compatible with 
the Avid version you are running. Once you enable Avid Style you don’t have to 
make any further configuration choices. 

However, some older 32-bit versions of Avid software — specifically Media 
Composer 4.x through 5.5.x — work with two different versions of EditShare’s 
Avid Style code. Once Avid Style is enabled in EditShare Connect, a Configure 
Avid Style option becomes available that allows you to override the choices that 
EditShare makes automatically. You might want to override EditShare’s 
automatic configuration in certain circumstances to better support specific 
workflows or features, such as exporting AAFs to Avid Style spaces, or 
mounting Avid Style Spaces by AFP. Overrides affect only Avid software 
between v4.x and v5.5.x. See the following table for a summary of the differences 
between New and Legacy Avid Style.
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*With the Legacy version of EditShare Avid Style, you couldn’t export an AAF 
from a sequence in a bin that was located in an EditShare Avid Style space. To 
export the AAF, you had to copy the bin to a local project and export from there. 
Similarly, if you were trying to export an AAF with embedded media, with the 
Legacy version of EditShare Avid Style, you had to first consolidate your media 
to a local drive or to an Avid MXF space, and export based on the consolidated 
media. Both of these issues were resolved with the New EditShare Avid Style for 
Mac.

Version Considerations: New Avid Style is not compatible with Media 
Composer or Symphony v2.8-3.5.x, and Legacy Avid Style is not available for 
v6.x and later. Overriding the Avid Style settings only affects v4.x-v5.5.x of Avid 
products; selecting New Avid Style for Avid v2.8-3.5.x or Legacy for v6.x has 
have no effect.

NOTE:  Once you begin using a space that is mounted by DAVE SMB, do not switch to 
AFP, and vice versa. Switching mount types may cause Avid to hang.

Setting up Avid Style Spaces on a Windows System

To enable and use Avid Style Spaces on a Windows 7 or Windows 8 
workstation, you must have successfully installed the EditShare Connect helper 
service. You are prompted to install this service every time you install or 
upgrade EditShare Connect. While you can install EditShare Connect as a 
non-Administrator, you must have administrator privileges to install the 
service. Once it has been installed, any user can enable or disable support for 
Avid Style in EditShare Connect. EditShare's Avid Style feature is supported on 
Windows XP 32-bit, Windows 7 64-bit and Windows 8 64-bit.  It should also be 
compatible with Windows Vista 32-bit, although EditShare does not regularly 
test with Vista.

The Windows version of EditShare Connect provides a special feature called 
Avid Launcher for starting Avid applications. You should always, and in some 
cases must, use Avid Launcher to access EditShare media spaces from Avid 
applications on Windows.

The Avid Launcher allows Avid applications to do the following:

• Access Avid Style spaces.

• With 32-bit Avid applications, do the following:

– See media space names as well as drive letters when you select an 
Avid MXF media space in Avid (for example, in the Capture tool, 
the Media tool, and the Media Creation dialog box).
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– Store long MXF clips on Avid MXF spaces without splitting them 
into 2 GB chunks.

– Capture HDV clips longer than about 10 minutes to Avid MXF 
spaces. (HDV cannot be split into multiple 2 GB chunks.)

– Import P2 or XDCAM clips larger than 2 GB to Avid MXF spaces.

– Use EditShare media spaces with older Avid applications that do not 
support the alldrives command.

See the following topics:

• "Installing and Configuring EditShare Connect for Windows" on page 47

• "Using Avid Launcher" on page 49

Installing and Configuring EditShare Connect for Windows

The EditShare Connect client installer is located in the SMB File Exchange of 
your EditShare storage server. To get the installer, enter your server’s IP address 
or host name in your workstation’s web browser. For example, if your EditShare 
server is at the IP address 192.168.1.100, enter http://192.168.1.100 in your 
browser. Click the “EditShare Connect Clients” link on the page, then click the 
file ending in .exe to download the Windows client to the workstation.

NOTE:  Always remember to update the EditShare Connect client on every workstation 
after updating the EditShare server software. EditShare Connect will notify users if an 
update is available.

NOTE:  If you have User Account Control enabled on your system, a warning message box 
might open at various stages in the procedure. You can safely click Yes.

To install and configure EditShare Connect:

TASK

1. If you plan to use Avid Style spaces, make sure you have Administrator 
privileges on the workstation.

2. Install the version of EditShare Connect that came with your server.

 NOTE:  If you’ve already installed EditShare Connect, skip to step 5.

The EditShare Connect Setup Wizard opens.
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3. Click Next and follow the instructions, then click Finish when done. If you are 
prompted by UAC to approve an action, click Yes.

4. Start EditShare Connect, log in, and click the Settings tab. 
 

5. Click Browse for Avid Application
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6. Select the Avid application you want Avid Launcher to start and click Open.
 

7. If you have other Avid applications, repeat steps 7 and 8 for each of them.

 You are finished with the configuration.

NOTE:  You only have to perform this procedure once per workstation, then again 
after installing Avid software updates.

Using Avid Launcher

To use Avid Launcher:
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TASK

1. Start EditShare Connect and log in.

2. Mount one or more of the spaces you intend to use.

3. Click the Avid Management tab.

 

4. To start your Avid application, select the application you want in the Avid 
Launcher list, and then click the Launch Application button.

 NOTE:  After configuring Avid Launcher, you must log into EditShare Connect 
and launch the Avid application from EditShare Connect if you wish to access 
projects and media stored on Avid Style spaces. If you launch EditShare Connect 
after starting the Avid application, you will see an error advising you to exit Avid 
and relaunch it from within EditShare Connect. 
 
If you start your Avid application before logging into EditShare Connect, a message 
prompts you to close your Avid application and restart it using the Avid Launcher.
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Click OK, then start EditShare Connect and use the Launch Avid Application button.

Similarly, if you try to start Avid by double-clicking the Avid icon, a message box opens.

Click OK, and then click the Launch Avid Application button.

Avid MXF Media Spaces in Detail

Avid MXF Media Spaces are designed to allow users of Avid editing software to 
work together safely. As the name suggests, these Media Spaces can be used only 
for media stored in the MXF format, not for OMF, AIF, or WAV files. Be sure 
to set your Avid application to capture video as MXF and audio as PCM (MXF). 
(If you do not make these changes, you cannot capture into an Avid MXF Media 
Space.) The following table describes features of Avid MXF Media Spaces.

Feature Description

Supported NLE All Avid (Media Composer, Avid Xpress Pro, Symphony Nitris, and so on), only for media 
stored in MXF format (audio as PCM (MXF))
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If you must capture your media in non-MXF formats, you need to use an Avid 
Style Space. 

When an Avid NLE captures MXF media, it captures it into a folder called Avid 
MediaFiles/MXF/1 (or potentially 2 or 3 if the first folder gets full). However, it 
also sees any media inside other subfolders of the Avid MediaFiles folder. Each 
folder has its own media database file, which Avid automatically updates when 
it creates or deletes media inside that folder. 

EditShare provides you with your own view of that Media Space, and you have 
your own numbered folder into which Avid captures. In your view of the Media 
Space, your own “1” folder is called 1 and you have full access to capture into it 
or delete media files from it. Other users' “1” folders, on the other hand, appear 
with different names, based on the names of the users, for example, max_1. Avid 
can see media in these folders, so you can play the media, mark In and Out 
points, and incorporate the media into your sequences. You cannot modify or 
delete the media there, however, or capture new media into the folders or use 
other tools (such as OS X Finder or Windows Explorer) to copy or move files 
into these folders.

The following illustrations show the structure of EditShare’s Avid MXF spaces 
and Avid Shared Project spaces.

Network Protocol Windows: SMB/CIFS. Mac: DAVE SMB or AFP

Access Control Users must be added to the Media Space to have access 
Users can be given read-only access 
Public option available

User Operations QuickTime Reference mode 
Hide user folders

Administrator Operations Protect/Unprotect mode 
Maintenance mode

Contents OMFI MediaFiles (not used) 
Avid MediaFiles/MXF/1 (folder you own, can capture into and delete from) 
Avid MediaFiles/MXF/# (other folders you own and can delete from) 
Avid MediaFiles/MXF/user_# (other users’ folders; view only)

Feature Description
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With Avid MXF spaces, each editor has his or her own view of the Media Space. 
UserB’s media is stored in a 1 or 2 folder (and so on). UserB sees UserA’s media 
in folders called UserA_1 and UserA_2. 

However, in another user's view of the Media Space, your numbered folders 
appear with different names, and their numbered folders are called “1” and “2” 
and so on, so that their Avid application captures uniquely into that user’s 
folders. 

You can create additional folders inside your MXF folder, with numbered 
names up to three digits (up to “999”). Avid applications generally do this when 
all existing numbered folders have more than 5,000 files in them. 

NOTE:  Do not create names with four or more numerals. Names with four or more 
numerals interfere with some important EditShare functions.

Also see the following topics:

• "Enabling Avid Editing Systems to See Avid MXF Spaces" on page 54

• "Making QuickTime Reference Movies from Avid" on page 56

• "Leaving QuickTime Reference Mode" on page 57

• "Hiding User Folders to Deal with Corrupted Media" on page 58

• "Protecting Media with the Protect Function" on page 59



CHAPTER 4: MEDIA SPACES
AVID MXF MEDIA SPACES IN DETAIL

 54

• "Deleting and Organizing Avid MXF Media with Maintenance Mode" on 
page 60

• "Deleting Avid MXF Media" on page 61

Enabling Avid Editing Systems to See Avid MXF Spaces

By default, Avid applications do not see Avid MXF spaces. In order to capture 
media into an EditShare Avid MXF Media Space, you must tell your Avid 
editing system to pay attention to those spaces. 

For users of Windows-based Avid systems, there are two ways to do this: 

• Avid Launcher: Makes 32-bit Avid applications see Avid MXF spaces

NOTE:  You must use the Avid Launcher if you are using Avid Style Media Spaces.

• The alldrives command: Required for 64-bit Windows Avid applications

• If your Avid system runs on Macintosh and you use Avid MXF or 
Traditional Media Spaces, you must use the alldrives method (there is no 
Avid Launcher for Mac). 

The method you use depends on the specific Avid application you are running 
and sometimes on the type of media files you are capturing or importing. In 
many cases, you can use a combination of both methods. 

However, if you use only Avid Style Media Spaces on a Mac, Avid sees the 
networked drives and you do not need to use the alldrives method.

See the following topics:

• "Using Avid Launcher" on page 49

• "The alldrives Command" on page 54

The alldrives Command

You can use this method for the following Avid applications and versions:

• Avid Xpress Pro v4 and later (except for some Macintosh OS X versions 
distributed before March 2004)

• Avid Xpress Pro HD

• Avid Xpress DV v3.5 and later (except for some Macintosh OS X versions 
distributed before March 2004)

• Media Composer
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• Media Composer Adrenaline

• Symphony Nitris

• NewsCutter

• NewsCutter XP

After you use this method, you should not have to do it again unless you update 
your Avid software to a new (major) version.

Do the following.

TASK

1. Open a project in your Avid application.

2. Select Tools > Console.

3. Type alldrives 1 and then press Enter.

 A message opens in the Console window that reads, “all drives will be viewed 
as media drives.”

4. Select File > Mount All.

 Your application now sees the mapped drives. If there are already media files 
in your Media Space, your system might start scanning the Media Space to 
build a new database. This is normal and completes in a few seconds or 
minutes. 

NOTE:  If the application does not see the mapped drives, select File > Refresh 
Media Directories. If it still does not see the mapped drives, quit the application 
and restart it.
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Making QuickTime Reference Movies from Avid

A side effect of the way Avid MXF Media Spaces present your data to you is that 
different users see the same media files in slightly different paths. For example, 
user edit1 might see a file captured as Z:\Avid MediaFiles\MXF\1\clip1.mxf, but 
user edit2 would see that same file as Z:\Avid 
MediaFiles\MXF\edit1_1\clip1.mxf. As long as you are only looking at the files 
within your Avid NLE, this is not a problem – each NLE finds the correct media 
file with no difficulty. 

However, if user edit1 were to create a QuickTime reference movie of a 
sequence that uses that clip, and send it to edit2 to review, edit2 would not be 
able to see the media because QuickTime does not know how to locate the 
media in a different folder. 

A workaround is to create special-purpose usernames. See "Making QuickTime 
Movies Using Special-Purpose Usernames" on page 56.

You can also work around this problem by using QuickTime Reference Mode 
(QRM). See "Making QuickTime Movies with QuickTime Reference Mode" on 
page 57 and "Leaving QuickTime Reference Mode" on page 57.

Making QuickTime Movies Using Special-Purpose Usernames

This is a newer and generally preferred procedure for making QuickTime 
movies, compared to with QuickTime Reference Mode (see "Making 
QuickTime Movies with QuickTime Reference Mode" on page 57).

TASK

1. Create two new users, called, for example, QTCreate and QTView.

2. Log in as yourself.

3. Render your sequence.

4. Log out.

5. Log in as QTCreate.

6. Create the QuickTime Reference file.

7. Log out.

8. To view the file, log in as QTView.

 NOTE:  Avoid viewing as QTCreate so you don’t conflict with another user who 
might be creating as QTCreate.
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Making QuickTime Movies with QuickTime Reference Mode

When you are in QuickTime Reference Mode (QRM) for a Media Space, your 
own numbered folders in that Space temporarily appear the same way that other 
users see them. The media stays the same, but the name of the folder is changed. 
You can then create the QuickTime reference movie you need, and it contains 
references to your media files in a way that other users can use. 

You might also need to enter QRM to play a QuickTime reference movie, if that 
file contains references to files in your numbered media folders.

NOTE:   While in QuickTime Reference Mode for a Media Space, you cannot capture or 
render any new files into that Media Space. Therefore, it is important that you render any 
effects in the sequences you need to make QuickTime reference movies of before entering 
QuickTime Reference Mode.

To place yourself in QuickTime Reference Mode to create QuickTime reference 
movies, do the following.

TASK

1. Render all effects in the sequences you plan to make QuickTime references of.

2. Close your Avid project.

3. Start EditShare Connect.

4. Click the Disabled button next to each Media Space that contains media you 
plan to include in your QuickTime reference movies.

 

 A dialog box opens telling you to log out of EditShare Connect and log back 
in for the changes to take effect.

5. Click OK.

6. Log out of EditShare Connect.

7. Start EditShare Connect and log in again.

8. Open your Avid project again. 

 You can now make the QuickTime reference movies you need.

Leaving QuickTime Reference Mode

To leave QuickTime Reference Mode, do the following.
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TASK

1. Close your Avid project.

2. Click the Enabled button next to each Media Space you are ready to return to 
normal.

 A dialog box opens telling you to log out of EditShare Connect and log back 
in for the changes to take effect.

3. Click OK.

4. Log out of EditShare Connect.

5. Start EditShare Connect and log in again.

6. (Option) Open your Avid project again. 

Hiding User Folders to Deal with Corrupted Media

You might need to isolate media files you do not control. For example, another 
user might have a corrupted media file that causes your Avid application to 
hang. You can do isolate that file by using the Hide User Folders function to 
hide one or more users' numbered MXF folders. 

The EditShare Administrator can also hide user folders for any user. This can be 
done when a problem has been discovered and the Administrator wants to hide 
it from other users without bothering them with it. See "Hiding User Folders to 
Deal with Corrupted Media" on page 58.

To hide user folders, do the following.

TASK

1. Start EditShare Connect.

2. Click the Hide button next to the Media Space containing the MXF folders you 
want to hide. 

 The Avid MXF Media Management dialog box opens.
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3. Select each folder you want to hide.

4. Click OK.

 The Hide button changes to Show All.

5. (Optional) Click the Show All button to show all the hidden folders and restore 
normal operations.

Protecting Media with the Protect Function

In many environments, it might be inappropriate for a user who captured media 
to be able to delete it. For example, a group of assistant editors might do logging 
and capturing, but they would not be expected to delete captured media.

To protect captured media from being modified by even the user who captured 
it, the EditShare Administrator (or a designated user) can use the Protect 
function. This makes all media already captured by a specific user read-only. 
Such media can no longer be moved, renamed, deleted, or modified by any user, 
including the user who originally created it. The user can still delete any new 
media he or she adds subsequently until the Protect function is run again.

One way to use this might be for the Administrator to Protect the media on a 
daily basis, when the assistant editors are finished capturing. The assistant 
editors could delete erroneously captured files immediately, but after the 
Administrator Protects the media, making changes requires additional 
maintenance.
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The Administrator can also Unprotect media created by one or more specific 
users, returning to each creator the ability to move, rename, delete, or modify 
all the files which had previously been Protected.

It is not necessary to use the Protect and Unprotect functions in order to work 
with an Avid MXF Media Space. If you don't use Protect, all your files are always 
under your control. However, Protect is the only way to ensure that media files 
in an Avid MXF Media Space are not mistakenly or maliciously modified. In an 
environment where media files are shared among many users, it can be very 
disruptive if important files are deleted.

Instructions for the Administrator to Protect and Unprotect Avid MXF Media 
Spaces can be found in the EditShare Administrator's Guide.

Deleting and Organizing Avid MXF Media with Maintenance Mode

Any user who captured files into an Avid MXF Media Space can normally delete 
those same files (unless the Media Space has been Protected). But when it's time 
to delete unnecessary files from a Media Space, it can be impractical to require 
each individual editor to participate in “cleaning up.” For example, a Media 
Space might have clips that were captured by many different people, and the 
lead editor wants to delete media that is not in use without having to involve all 
the users who captured the files.

To address this need, the EditShare Administrator (or a designated user) can 
place an Avid MXF Media Space into Maintenance Mode, giving one specified 
user (called the “maintenance user”) the ability to freely move, rename, delete 
and modify files in that Media Space regardless of who originally captured 
them. See "Deleting Avid MXF Media" on page 61. The maintenance user 
should be selected carefully, as he or she has the ability to do great damage to the 
media.

If you are the maintenance user, you see a change in the names of other users' 
subfolders of the MXF folder. Instead of seeing names such as user2_1, the 
subfolder names change to purely numeric names, such as 5011. This allows 
your Avid application to modify the contents of all the folders, including their 
media databases. A file called maintenance_users.txt is created in the top-level 
folder of the Media Space, providing a table linking the original names of the 
folders to their new names in Maintenance Mode. This helps you to know which 
folders are owned by which users.

It is generally best, if possible, to have all other users besides the maintenance 
user unmount from the Media Space before maintenance begins. If any users 
have the Media Space mounted during maintenance, you might notice the 
following:
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• All other users are restricted to read-only access. In fact, an Avid MXF 
Media Space cannot be put into Maintenance Mode while any files are 
being captured or rendered into it, and while in Maintenance Mode it is 
not possible for anyone other than the maintenance user to save any new 
files into the Media Space.

• Other users immediately see the changes being made by the user who is 
doing maintenance. Files might disappear or be moved without warning 
to them. This might be confusing.

• If you have a file open (that is, if you are playing the media from it) when 
the maintenance user attempts to move or delete the file, the operation 
might not happen as intended. A file cannot be deleted while it is open. It 
should be deleted after it is closed (that is, when you stop playback) but 
this might not be completely reliable.

Deleting Avid MXF Media

To delete Avid MXF media in Maintenance Mode, do the following.

TASK

1. Make sure all other users have unmounted the Media Space from which you 
want to delete media.

2. Have your Administrator place the Avid MXF Media Space into Maintenance 
Mode for a particular user.

3. Open EditShare Connect as the Maintenance Mode user.

4. Start the Avid application.

5. Select the shared project space.

6. Create a new local bin.

7. Copy, duplicate, or move the media you want to delete to the local bin.

8. Delete the media metadata and media files.

9. Close the Avid application.

 NOTE:  You must close the Avid application before the Media Space is taken out 
of Maintenance Mode. After you delete clips, Avid might not modify its media 
databases until the application is closed. If the Media Space is taken out of 
Maintenance Mode first, you can no longer modify the media database files in 
other users' numbered MXF folders.
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10. Have the Administrator take the Media Space out of Maintenance Mode.

 The Administrator can save a backup copy of all deleted files into the 
EditShare Trash for possible restoration in case it is later discovered that one 
or more files were deleted that should not have been.

NOTE:  See “Organizing and Deleting Media” in the EditShare Administrator's 
Guide for information about restoring deleted files.

Managed Media Spaces

Managed Media Space Feature Description

Supported NLE Final Cut Pro, Adobe Premiere Pro, Media 100, Edius Canopus, Avid (formerly 
Pinnacle) Liquid, and so on (Avid can import from or export to a Managed or 
Unmanaged Media Space). 

Network Protocol Any SMB or AFP.

Access Control Users must be added to the Media Space to have access. 
Public option.

User Operations None.

Administrator Operations Protect/Unprotect mode. 
Maintenance mode.

Contents Created as necessary by NLE.

Managed Media Spaces are designed to allow users of non-Avid editing 
software to work together easily, while still protecting files from inadvertent 
modification or deletion. The following table describes features of Managed 
Media Spaces.

In a Managed Media Space, all editors access the same view of the Media Space. 
Files you capture, render, transfer, import, or otherwise create in the Media 
Space are immediately visible to other users. You can create subfolders inside 
the Media Space, and you can move, rename, delete, or modify the files you have 
captured any way you like to organize and manage your media. However, you 
cannot modify files that other users created, and they cannot modify files you 
created. 

Managed Media Spaces do not provide any special folders for your use. You can 
freely create whatever folders you need to organize your media in whatever way 
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works for your organization. Most NLE software automatically creates some 
folders (for example, Final Cut Pro creates a Capture Scratch folder to capture 
media into), and you are free to create any additional folders supported by your 
NLE. 

In a Managed Media Space, you may not rename, move, or delete folders with 
contents. This protects media from accidental deletion. Once the contents of a 
folder have been moved elsewhere or deleted, the folder may be modified.

Do not try to use Managed Media Spaces as a capture or render destination for 
Avid editing software, unless only one editor ever mounts the Media Space at a 
time. If two editors ever mount the Media Space at the same time and run Avid, 
it is very likely that the media database in the Media Space will become 
corrupted, making your media inaccessible until the media database is rebuilt. 
However, it is safe to use a Managed Media Space as a source from which you 
import files into Avid (which stores them in an Avid MXF or Traditional Avid 
Media Space), or as a destination into which to export files from Avid.

Also see the following topics:

• "Tracking Who Controls Which Files in Managed Media Spaces" on page 
64

• "Organizing Media by Tape or Subject" on page 64

• "Protecting Media with the Protect Function" on page 65

• "Deleting and Organizing Managed Media with Maintenance Mode" on 
page 66
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Tracking Who Controls Which Files in Managed Media Spaces

There is no automatic way to see who created (and therefore controls) which 
files. However, you can establish a convention in your organization that allows 
you to easily track who controls which files.

Each editor can make his or her own folder inside the Media Space, and capture 
and render files into only that folder. For example, a Managed Media Space used 
for a Final Cut Pro project could have a folder structure that looks like the 
following:

Max can access Allan’s files, and vice versa, but the two sets of files stay separate. 
In a Managed Media Space, nothing prevents Max from capturing files into 
Allan’s folder. Editors must take responsibility for following the conventions 
established for the organization.

Organizing Media by Tape or Subject

Final Cut Pro editors often want to organize captured media files by tape 
number or subject matter within a single Capture Scratch folder. Even though 
Final Cut Pro only captures into the main Capture Scratch folder, a Managed 
Media Space allows the editor who captured files to move them into any other 
folder in the Media Space.
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Create the media folders structure the way you want it inside the Media Space. 
Then, after you capture some clips, move the media files out of the main 
Capture Scratch folders into those “subject matter” folders. For example, you 
might create the following folder structure for a TV program about 
the Mediterranean.

Files should be properly named and moved before other editors start working 
with them, or else the files might suddenly go offline and other editors have to 
reconnect the clips in their sequences.

Protecting Media with the Protect Function

In some environments, it might be inappropriate for a user who captured media 
to be able to delete it. For example, a group of assistant editors might do logging 
and capturing, but they would not be expected to delete captured media.

In order to protect captured media from being modified even by the user who 
captured it, the EditShare Administrator (or a designated user) can use the 
Protect function. This makes all media already captured by a specific user 
read-only. Such media can no longer be moved, renamed, deleted, or modified 
by any user, including the user who originally created it. The user can still delete 
any new media he adds subsequently, until the Protect function is run again.

One way to use this might be for the Administrator to Protect the media on a 
daily basis, when the assistant editors are finished capturing. The assistant 
editors could delete erroneously captured files immediately, but once the 
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Administrator Protects the media, making changes requires additional 
maintenance.

The Administrator can also Unprotect media created by one or more specific 
users, returning to each creator the ability to move, rename, delete, or modify 
all the files which had previously been Protected.

It is not necessary to use the Protect and Unprotect functions in order to work 
with a Managed Media Space. If you don't use Protect, all files are always under 
the control of the user who created them. However, Protect is the only way to 
ensure that media files in a Managed Media Space are not mistakenly or 
maliciously modified. In an environment where media files are shared among 
many users, it can be very disruptive if important files are deleted.

Instructions for the Administrator to Protect and Unprotect Managed Media 
Spaces can be found in “Protecting Media Spaces” in the EditShare 
Administrator's Guide.

Deleting and Organizing Managed Media with Maintenance Mode

Any user who captured files into a Managed Media Space can normally delete 
those files (unless the Media Space has been Protected). When it's time to delete 
unnecessary files from a Media Space, however, it can be impractical to require 
each individual editor to participate in “cleaning up.” For example, a Media 
Space might have clips that were captured by many different people, and the 
lead editor might want to delete media that is not in use without having to 
involve all the users who captured the files.

To address this need, the EditShare Administrator (or a designated user) can 
place a Managed Media Space into Maintenance Mode, giving one specified 
user (called the “maintenance user”) the ability to freely move, rename, delete 
and modify files in that Media Space regardless of who originally captured 
them. The maintenance user should be selected carefully, as he or she can 
potentially do great damage to the media.

It is generally best, if possible, to have all other users besides the maintenance 
user disconnect from the Media Space before maintenance begins. If any users 
remain connected during maintenance, you might notice the following:

• All other users are restricted to read-only access. No one besides the 
maintenance user can save any new files into the Media Space while it is 
in Maintenance mode.

• Other users immediately see the changes being made by the user who is 
doing maintenance. Files might disappear or be moved without warning. 
This can be confusing.
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• If you have a file open when the maintenance user tries to move or delete 
it, the operation might not happen as intended. A file is not deleted while 
it is open. Consider further the following:

– If the Media Space is mounted using SMB, the file should be deleted 
once it is closed (that is, not being played), but this might not be 
completely reliable.

– If the Media Space is mounted using AFP, the file is not deleted and 
no warning is given to the maintenance user. It appears that the file 
was deleted, but it was not.

When the maintenance is complete, the Administrator can confirm the changes 
and leave Maintenance Mode. A backup copy of all deleted files can be saved in 
the EditShare Trash for possible restoration if it is later discovered that one or 
more files were deleted that should not have been. See “Organizing and Deleting 
Media” in the EditShare Administrator's Guide for information about restoring 
deleted files.

Universal Media Spaces

Universal Media Spaces are only for use with EditShare Flow. For more 
information, see your Flow documentation.

Unmanaged Media Spaces

Unmanaged Media Spaces are designed to provide the simplest possible 
management: none. In an Unmanaged Media Space, all editors access the same 
view of the Media Space. Files you capture into an Unmanaged Media Space are 
immediately visible to other users. You can create subfolders inside the Media 
Space, and you can rename, move, or delete any files inside it, whether you 
created them or not. Any other user with access to the Space can also modify 
your files. No restrictions or controls are available to protect against accidental 
or malicious overwriting of the contents.

The following table describes the features of Unmanaged Media Spaces.



Feature Description

Supported NLE Limited support for all NLEs except Avid (Avid can import from or export to a 
Managed or Unmanaged Media Space). The only kind of space that can be used for 
stored FCP-X Events and Projects. Best for ProTools sessions.

Network Protocol Any SMB or AFP

Access Control Users must be added to the Media Space to have access 
Up to 20 users can be limited to read-only access 
Public option

User Operations None

Administrator Operations None

Contents Created as necessary by NLE
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In general, EditShare recommends using Avid MXF, Avid Style, or Managed 
Media Spaces in preference to Unmanaged Media Spaces. If you do choose to 
use an Unmanaged Media Space, you need to coordinate carefully with other 
members of your organization to be sure you do not modify files other editors 
might be relying on.

Unmanaged Media Spaces do not provide any special folders for your use. You 
can freely create whatever folders you need to organize your media in whatever 
way works for your organization. Most NLE software automatically creates 
some folders (for example, Final Cut Pro creates a Capture Scratch folder to 
capture media into), and you are free to create any additional folders supported 
by your NLE. 

Do not try to use Unmanaged Media Spaces as a capture or render destination 
for Avid editing software, unless only one editor ever mounts the Media Space 
at a time. If two editors mount the Media Space at the same time and run Avid, 
it is very likely that the media database in the Media Space becomes corrupted, 
making your media inaccessible until the media database is rebuilt. However, it 
is safe to use an Unmanaged Media Space as a source from which you import 
files into Avid (which stores them in an Avid MXF or Traditional Avid Media 
Space), or as a destination into which to export files from Avid.
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EditShare Connect Profiles

When working on a single editing project, it’s not unusual for editors to want to 
mount more than one Media Space. For example, the editor might put all raw 
clips into one space that's dedicated just for that project. Then the editor might 
put render files into a second space that's also dedicated just for that project to 
help keep renders segregated so that they are easy to manage and delete. There 
might be a third space with a music library that's used over and over again for 
many projects, and a fourth space for graphics elements and stills. 

On complex projects – for example, a 26 part documentary or reality series – it's 
not unusual to have different spaces for each episode or day of shooting. It's also 
not unusual for editors to need material from other episodes in addition to the 
specific one they're working on – for instance, for things like “recaps” and 
“previews”. 

To help make it easy to switch from one editing project to another and always 
have the right spaces mounted, EditShare now includes a Profile feature that lets 
you group spaces together and give the group a name that's informative and easy 
to remember, so that you can mount all of them at the same time with a single 
click in EditShare Connect. There are many situations besides complex series 
where this can be convenient. For example: 

Let's say you work at a post house that has twenty clients. You can have a Profile 
for each client so that any time you have a job for that client, you can instantly 
connect to all the right Spaces associated with that client. If your post facility did 
work for both Coca Cola and Pepsi, for example, you wouldn't want to 
accidentally use Coca Cola's stock shots in a Pepsi commercial, right? So Profiles 
can help you keep things straight and switch between clients very rapidly. 
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By default, the first time you launch EditShare Connect, it opens up with the 
“All Spaces” Profile. As the name implies, the “All Spaces” Profile will always 
show you “all the Spaces that you have access to”. After loading the All Spaces 
Profile, you can mount spaces manually and when you log out and log back in 
again, whatever spaces you had mounted when you logged out (and for 
Windows users, whatever drive letter they were assigned to) will be 
remembered when you log back in again and automatically reconnected. 

The real power of Profiles, however, comes when you start creating Profiles that 
are tailored for specific projects. When you create a New Profile, you give it a 
name and – if you want – you can choose an existing Profile to use as the base 
or template for the new one. If you had 20 spaces in an existing Profile and you 
wanted to create a new Profile that included 12 of those 20 spaces, plus some 
other ones, using the first Profile as the starting point for the new Profile can 
help you get the new one set up quickly. 

To switch Profiles, you simply click on the “Change Profile” button and select 
the new Profile you want to load. All of the spaces in the currently loaded profile 
get unmounted, and then all of the Spaces in the newly-selected Profile get 
mounted. 

NOTE:  The profiles you create are for your use only – in other words, only you can see 
them and load them. However, your EditShare Administrator may also create Profiles 
that are available to everybody. These are called “Public Profiles”. In the list of Profiles 
that are available to load, you will see both your own private “Profiles” as well as “Public 
Profiles”. 

Creating a Private Profile

To create a Private Profile:

TASK

1. If you already have a Profile loaded, click the “Change Profile” button.

 When you change Profiles, that will unload the current Profile and unmount 
any spaces that are currently mounted. 
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2. In the next window, click on the “New” button.
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3. In the Name field, type a name for the Profile.

 

4. (Optional) If you want to use an existing Profile as the starting point for your 
new Profile, select one of the Profile names. You can select multiple existing 
Profiles and combined spaces will be selected automatically in your new 
Profile. If you have many existing Profile, you can type part of the name in the 
“Filter” field and it will limit the display of existing Profiles to the ones that 
match the letters you typed. 

5. Click on the “Create” button to create the new Profile.

6. Select one or more spaces to add to the Profile and indicate whether the space 
should be mounted by default or not, and in the case of Windows, what drive 
letter it should get. 

 NOTE:  It is possible to have unmounted spaces in a Profile. For instance, let's 
say you are working in Windows and you want to put more spaces into the 
Profile than there are letters of the alphabet. It is not possible to have them all 
mounted at the same time, but you might want to keep them all in your 
Profile. Another case where you might want to have unmounted spaces in 
your Profile could be when there are corrupted files in one of the spaces; it 
may be necessary to keep the space unmounted so that it doesn't confuse 
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your editing application, but you don't have to remove the space from your 
Profile for it to be unmounted.

 

7. When you are done adding spaces to your Profile, click the “Finish Editing” 
button. 

Selecting a Profile in EditShare Connect

TASK

1. Depending on whether this is your first time launching EditShare Connect or 
not, the initial display may be the “Choose Profile” window or a “Current 
Profile” window. 

2. If it is the “Choose Profile” window, double click on the profile you want to 
load.  If it the “Current Profile” window, clicking on the “Change Profile” button 
will take you to the “Choose Profile” window. 
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Edit a Profile

TASK

1. With your Profile already loaded, click on the “Edit Profile” button.

2. In the next window, one or more spaces to add or remove from the profile.  If 
the spaces are to be included in the Profile, select whether to mount them or 
not, and on Windows workstations select the drive letter. 

3. When you are done editing the Profile, click on the “Finish Editing” button. 



Chapter 5: Metadata Spaces

Metadata is all files that are not media files. Depending on your NLE, metadata 
might include project files, bins, sequences, and settings files. The essential fact 
about metadata files is that they are frequently changed during the course of 
editing.

See the following topics:

• Private Files Spaces

• File Exchange Spaces

• Spaces for Storing and Sharing Avid Projects

• Project Sharing with Final Cut Pro 6 and 7, Adobe Premiere Pro, and 
Other NLEs

• Lockable Project Spaces

Private Files Spaces

Private Files Space Feature Description

Supported NLE N/A

Network Protocol SMB or AFP

Access Control Each user has one Private Files folder, accessible only by that user

User Operations None

Administrator Operations All Private Files spaces can be disabled by the Administrator

Contents Created by user

Unless the EditShare Administrator disables this feature, you are provided with 
a Private Files space on the EditShare server. This is a private Space for your 
exclusive use. The following table describes features of Private Files spaces.

Your Private Files space is a private place to store project metadata files on the 
EditShare Server. It is not a place to put media files. In fact, EditShare blocks 
most media files from being stored in your Private Files space (any file with a 
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*.omf, *.mov, *.aif, *.wav, *.avi, *.mp3 extension, among others). The EditShare 
server stores all users’ Private Files spaces on a drive of limited capacity. If you 
were to store media on it, you would quickly fill the drive and prevent everyone 
else from using their Private Files spaces.

Private Files spaces are the safest place on the EditShare Server to store your 
personal metadata files. Only you can access your Private Files space. No other 
user can access or erase your project data unless they know your username and 
password. You can access your Private Files space from any computer on your 
network, which allows you to create, open, or modify your projects from any 
workstation where you can log in. 

It is possible that your access to your Private Files Space has been disabled by 
your Administrator. To access your Private Files space, see your EditShare 
Administrator.

File Exchange Spaces

File Exchange Space 
Feature Description

Supported NLE N/A

Network Protocol SMB File Exchange: SMB only 
AFP File Exchange: AFP only

Access Control All users can freely read and write

User Operations None

Administrator Operations File Exchange Spaces can be disabled by the Administrator

Contents Created by user

The SMB File Exchange and AFP File Exchange spaces are public locations that 
can be read and written to by anyone who logs onto the EditShare Server. On a 
Windows workstation, you see only SMB File Exchange. On a Macintosh, you 
can see both, but you can only connect to SMB File Exchange using Native SMB 
or DAVE SMB, and to the AFP File Exchange using AFP. 

The following table describes features of File Exchange Spaces.

The purpose of the File Exchange Spaces is to allow editors to exchange 
metadata files with each other. For example, you could copy project files, bins, 
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or sequences you want to share into a File Exchange Space, and other editors 
who want to work with those files in turn can copy the files into their own 
private Space, that is, their own Private Files Space on the EditShare Server, or 
into a project folder on their own local computer.

Like your Private Files Space, the File Exchange Spaces are not the place to put 
media files. The File Exchange Spaces are located on a drive of limited size, and 
if you were to store media in them, you would quickly fill the drive and prevent 
everyone else from using their File Exchange Spaces. 

The File Exchange Spaces are readable and writable by everybody. Any file put 
there can be modified or deleted by anybody. You should not consider the File 
Exchange Spaces to be secure or safe places to store your personal files. They are 
only places for trading copies of those files. 

NOTE:  At no time should you directly open up project files, bins, or sequences from the 
File Exchange Spaces, as there is no guarantee that other editors won’t also do the same 
thing. If two editors open exactly the same project file, bin, or sequence, important data 
might be lost. 

Your access to the File Exchange Space might be disabled by your 
Administrator. To access your File Exchange Space, see your EditShare 
Administrator.

Spaces for Storing and Sharing Avid Projects

Avid projects consist of metadata files that represent bins, sequences, and 
preferences. Whenever you create a new project with your Avid application, 
Avid creates a folder in the place you specified in the Select Project window, 
with the name you gave the project. Avid normally stores these files on your 
local drive.

You can override the default and store Avid projects wherever you want, 
however, including in an EditShare Avid Shared Project Space or an Avid Style 
Space. Inside each Avid project folder, Avid creates a settings file that contains 
information about how you have customized your Avid application for that 
project, and a bin file for each of the bins you create in your project. These 
folders and files do not contain any media clips. They contain only metadata 
that refer to the media clips stored elsewhere, for example, on your EditShare 
server.

If you want to collaborate or share projects, you need to store your project files 
on the EditShare server. The key to successful project sharing is that no two 
editors should be allowed to modify the same metadata files at the same time. 
This is called metadata or file locking. 
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There are three methods for collaborating on an Avid project with other users:

• Create your Avid projects in an Avid Style space. Many facilities like to 
make a dedicated Avid Style space just for projects and keep their media 
in various other Media Spaces. (While you can keep your media with your 
project, you don’t have to.) See “EditShare Avid Style Sharing” on page 78

• Use Avid Shared Project Spaces (see "Shared Project Spaces" on page 87). 
This allows multiple Avid editors to work simultaneously on the very 
same metadata files without danger.

• Trade Avid bins between editors (whether you keep them on your local 
hard driver or in your Private Files Spaces). 

Also see the following topics:

• "Sharing Avid Projects Using Avid Shared Project Spaces" on page 81

• "Creating a New Avid Shared Project" on page 82

• "Collaborating by Copying Metadata" on page 84

• "Sharing Media without Collaborating on Projects" on page 85

EditShare Avid Style Sharing

EditShare offers a way to share Avid media and projects called Avid Style 
sharing. If you are accustomed to working with Avid Unity or Avid ISIS, you 
will find EditShare Avid Style sharing very familiar.

This section presents all the information you need about setting up and using 
Avid Style sharing.

See the following sections:

• Introduction to Avid Style Sharing

• Avid Style Workflow

• Sharing Projects with an Avid Style Media Space

• Restrictions on Modifying Media

Introduction to Avid Style Sharing

While EditShare pioneered the first non-Avid system for sharing bins, 
sequences and media, EditShare offers an additional system for collaboration 
with these assets. Avid Style Sharing provides bin-locking and media sharing 
that works the same way as Avid's Unity and Isis storage. 
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Each approach has its advantages. For example, the original EditShare way of 
sharing bins via User folders is probably much more secure for schools and big 
organizations where individual editors want some guarantee that their bins and 
sequences cannot be modified by others. Similarly, deleting files and rebuilding 
media databases is both safer and easier with EditShare's Avid MXF spaces. 

If you are an Avid editor accustomed to the way Unity works, however, you do 
not need to learn a new way of doing things. With EditShare's Avid Style 
Sharing, you get both Avid Style bin-locking and the Avid way of associating 
media files with the workstation that created them. In addition, with Avid Style 
Spaces, you get a small performance boost that can be important when you 
ingest or output sequences with six or more audio tracks.

With EditShare, you also aren’t forced into using only one approach. For 
example, you can use Avid MXF Media Spaces for your media and Avid Style 
Media Spaces for your bins.

For Avid projects stored in Avid Style Media Spaces, any bin can be opened 
Read-Write by the first user who opens it. This is represented in the Avid 
application by a green lock icon on the bin.

Any subsequent users have only Read access, which is represented by a red 
lock icon. 
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Avid Style Workflow

The general process of using Avid Style sharing is as follows:

1) Create an Avid Style Media Space for your Avid project in EditShare 
Manager. See "Avid Style Media Spaces in Detail" on page 42, and 
“Chapter 10: Creating Media Spaces” in the EditShare Administrator’s 
Guide.

2) (Mac only) Enable Avid Style in EditShare Connect. See "Setting up Avid 
Style on a Mac OS X System" on page 43. 

3) Create a new Avid project in the Avid Style Media Space, and work in the 
project with your shared media. See "Sharing Projects with an Avid Style 
Media Space" on page 80.

Sharing Projects with an Avid Style Media Space

To share projects with an Avid Style Media Space, do the following.

TASK

1. Log in as Administrator on your workstation.

2. Start EditShare Connect and mount an Avid Style Media Space.

3. Start the Avid application. 

 NOTE:  If you want to start Avid without using the Avid Launcher, you must 
Disable Avid Style in the Avid Style section of the EditShare Connect Settings tab.
The Select Project dialog box opens.

4. Create a new External project in the Avid Style Media Space your system 
Administrator created for your Avid projects. 

 When you open a bin, the lock icons appear – green for unlocked and red for 
locked – and the first user to open the bin can make changes to it. 
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Unlike with regular Shared Project Spaces, you do not have to Share the new 
project for other users to have access to it. 

5. Right-click the bin and select Lock or Unlock. 

 See your Avid documentation for additional information on using locked 
and unlocked bins.

Restrictions on Modifying Media

The following restrictions pertain to an Avid Style Media Space:

• All files are owned by all of the members of the Media Space—including 
media files, media database files, project settings and bins—and any 
member can permanently modify or delete files from an editing 
application, OS X Finder, or Windows Explorer. 

• Any bin can be opened Read-Write by the first user who opens it. Any 
subsequent users who open it while it is still open by the first user have 
only Read access. This is represented by a green lock icon on the bin 
opened by the first user, and a red lock icon for subsequent users.

Sharing Avid Projects Using Avid Shared Project Spaces

Avid Shared Project Spaces are often preferred by schools and universities 
because write access is controlled by the User Folder where a bin resides, unlike 
with Avid Style spaces, where the first user to open a bin gets write access, with 
Shared Avid Project Spaces. In an Avid Shared Project Space, User A cannot 
take a bin out of User B’s folder. User A has only read-only access to User B’s 
bins unless User B wants to give up control over the bin.

The following illustration shows EditShare’s Avid Shared Project Spaces. 
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The process of working with an Avid Shared Project Space is generally as 
follows:

1) The EditShare Administrator creates the Avid Shared Project Space and 
adds users to it.

2) You create an Avid project in the Avid Shared Project Space, set the 
project settings, and Share it using EditShare Connect. 

3) All users have their own folders within the project and can create bins in 
them.

4) You capture media, create and edit sequences, and perform other editing 
functions.

See the following topics:

• "Creating a New Avid Shared Project" on page 82

• "Set Project Settings before Sharing" on page 83

• "Collaborating by Copying Metadata" on page 84

• "Adding Titles to Shared Projects" on page 85

• "Deleting Avid Projects from a Shared Project File Space" on page 85

Creating a New Avid Shared Project

Once the EditShare Administrator has created an Avid Shared Project Space, 
you can create and share Avid Projects in it by doing the following.

TASK

1. Use EditShare Connect to mount the Avid Shared Project Files Space on a 
drive letter (Windows) or via AFP or SMB (OS X).
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2. Mount one or more Media Spaces in which to store captured media and 
rendered files for this new project.

3. Start your Avid application.

 The Select Projects dialog box opens.

4. Click the Folder button and navigate to the Avid Shared Project Space.

 NOTE:  Do not select the Archive folder inside the Space. You cannot Share a 
project inside the Archive folder.

5. Create an Avid project.

 You are the only one who can access the project; it has only a single bin that 
shares the name of the project.

6. Close the project.

7. Start EditShare Connect and click the Projects tab.

8. Click the Refresh button to update the display. 

 The new project appears below.

9. Select the new project and click the Share Projects button.

10. Return to the Avid application and open the project.

 NOTE:  Once a project has been Shared, do not try to move or rename it. This 
causes your project to stop working correctly. The EditShare Administrator can 
organize projects using EditShare Manager.

Set Project Settings before Sharing

When you Share an Avid project, EditShare gives a copy of the project settings 
file to each user in the Shared Project Space. These become the initial project 
settings that each user has when first opening the shared project. If you want 
your project to have specific settings that are used by all editors (for example, to 
use the 1080i format and capture with PCM sound), save these settings before 
Sharing the project. Otherwise, each editor has to correct his or her own settings 
later.
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Collaborating by Copying Metadata

Avid saves each bin you create as a separate file, which contains all the metadata 
information about all the clips and sequences in the bin. You must have a least 
one bin for every Avid project, but editors usually create multiple bins for each 
project.

If you choose not to use EditShare's Avid Project Sharing feature, you can still 
work collaboratively by trading copies of bins among multiple editors, a 
technique that has been used since Avid systems first came out. EditShare 
makes trading bins easy by providing an easily accessible public Space where 
editors can swap bins.

Due to the way Avid stores captured clips, it is difficult for other editors to 
simply look at the Media Space and import the clips they need, as they might 
with other NLEs. It's much easier to create one or more bins full of captured 
clips, and then put a copy of those bins in the Shared Project Files Space on 
EditShare. Other editors can then copy those bins into their own project folder, 
and have the clips. Note that only the metadata about the clips is being copied 
in this procedure, not the media itself. A single copy of the media remains in the 
Media Space, accessed by all editors.

To work collaboratively, do the following.

TASK

1. Create a project, and capture media into a Media Space.

2. Create sequences in one or more bins.

 It can be helpful to copy specific items into one bin you’re going to share, 
naming it clearly.

3. Save the bin you want to share.

4. Open the following folders on your desktop:
• The folder where you store your Avid projects

• The Shared Projects Files Space on the EditShare Server

 NOTE:  You can create shortcuts on your desktop to these folders, making them 
easier to find when you need them.

5. Inside the Shared Project Files Space, make a new folder with your name.

6. Copy the bin you want to share from your private Avid Projects Space to the 
new folder in the Shared Project Files Space.

 NOTE:  If you store your Avid Projects files on your local workstation, you can copy 
the bin you want to share to the EditShare Server’s Shared Project Space by 
dragging the bin from your local folder to the server folder. Because these folders 
actually reside on two separate volumes (one on your local workstation and one on 
EditShare), when you move the bin from one place to another, Windows and OS X 
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copy the bin rather than cutting and pasting. (This might not work if you store your 
Avid project files on the EditShare server.)
 The other editor can now copy the shared bin from the Shared Project Files 
Space on the EditShare server to his or her private Avid Projects Space, can 
open your clips and sequences, and can drag them into another bin.

7. Delete the bin from the Shared Project Files Space on EditShare when it’s clear 
that nobody else needs a copy.

Adding Titles to Shared Projects

When you add a title to a sequence in a shared project and save the sequence in 
a shared bin, another user might see the title as offline. To enable other users to 
see a new title, you need to close the bin after you save it. If that doesn’t work, 
select File > Refresh Media Directories in the Avid application.

Deleting Avid Projects from a Shared Project File Space

It is impossible for individual editors to delete an Avid Project from an Avid 
Shared Project Space once the Avid Project has been shared. Only the EditShare 
Administrator can delete a Shared Project. For more details, see the EditShare 
Administrator's Guide.

Sharing Media without Collaborating on Projects

Even if you don't want to share Avid Projects or bins, you can still use Avid's 
Media Tool to find and use clips that another user has captured into a Media 
Space that you have access to. You can sort clips in the Media Tool by name, 
date, or tape number. When you find the clips you're looking for, drag them into 
a bin in your current project. This creates a new pointer to the clip that you can 
use. The media file itself is not duplicated. See your Avid application Help for 
more information.

Project Sharing with Final Cut Pro 6 and 7, Adobe Premiere Pro, 
and Other NLEs

In order to use EditShare's Project Sharing features most effectively with NLEs 
other than Avid, it helps to think about projects a little differently than you 
might have in the past. Normally, a project consists of a single project file. That 
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is, no matter how many clips, bins, or sequences you have in your project, all the 
information is packaged up in one big project file. Unfortunately, having 
everything in a single project file makes it impossible to give different members 
of a group of editors exclusive control over different parts of a project. This 
makes it very difficult to work collaboratively. Furthermore, as many Final Cut 
editors have experienced, when project files get very large, it can take a long time 
to open them, because the NLE must locate every media file referenced by the 
project file. 

Some other nonlinear editing programs (such as Avid or Edius) create a 
separate file for each bin inside the project. The project itself is represented by a 
Project Folder, which contains the files representing each bin in the project. 
That kind of structure makes it possible to assign specific rights to individual 
bins – each of which represents a different part of the overall Project. 

Although Final Cut Pro and Adobe Premiere Pro weren’t designed to work this 
way, it is easy enough to use them this way. Because the NLE allows you to open 
up more than one Project at the same time, you can treat the Project files the 
same way many other NLE programs treat bins.

That is, whereas in Avid you might have one or two bins for rushes and a 
separate bin for each sequence, with the other NLEs you can create a separate 
Project file for each part of the project and open up multiple project files to see 
as much of the Project as you need to see to work on it. A complete Project 
actually ends up being a folder full of smaller Project Files. 

This scheme has the following advantages over the traditional way of working 
with projects:

• Different ownership rights can be assigned to each Project file, allowing 
multiple editors to open up the same files at the same time while ensuring 
that only one editor at a time can write to that file.

• You can open only the part of the project that you need to work with, 
saving time by not having to open a huge project to work with only a small 
piece of it.

• Your work is not impaired. If you are working on Act 1 of a program and 
Editor 2 is working on Act 2, each of you can open both your own project 
file (containing the act you are working on), and also an Assistant Editor's 
Rushes Project file, for example, that contains all the rushes and subclips. 
You can copy the clips you need from the Assistant Editors Project into 
your own Act 1 Project file (this only copies clip, subclip and sequence 
references – it doesn't duplicate any media files). You can also work 
directly from the Assistant's Project and drag clips into a sequence that is 
saved in your own Act 1 Project file. And if Editor 2 wants to see what you 
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are doing, he or she only needs to open your project and view the 
sequences it contains.

EditShare offers two different types of spaces for sharing Final Cut Pro and 
Adobe Premiere Pro projects:

• Non-Avid Shared Project Spaces

• Lockable Project Spaces

In Non-Avid Shared Project Spaces, control over project files is determined by 
the user folder where the file resides. In Lockable Project Spaces, Read-Write 
access to a project file is given to the first user who opens the file. Subsequent 
users are restricted to Read-Only access. Lockable Project Spaces work much 
the same way as Avid Unity and ISIS, only for other NLEs such as Final Cut Pro 
and Adobe Premiere Pro.

Shared Project Spaces

Non-Avid Shared Project Spaces are available to help Final Cut Pro and Adobe 
Premiere Pro users collaborate on projects. 

The process of working with a non-Avid Shared Project Space is generally as 
follows:

1) The EditShare Administrator creates the non-Avid Shared Project Space 
and adds users to it.

2) The EditShare Administrator or an editor creates a Project Folder inside 
the Shared Project Space.

3) You have your own folder within the project and can save Project Files in 
them.

4) You capture media, create and edit sequences, and perform other 
editing functions.

5) When the project is complete, the EditShare Administrator deletes the 
project from the Shared Project Space, or deletes the entire Space itself.

Do not try to move or rename a project. This causes your project to stop 
working correctly. The EditShare Administrator can organize projects using 
EditShare Manager.

The following table describes features of Non-Avid Shared Project Spaces.



Shared Project Space 
Feature Description

Supported NLE Final Cut Pro 6 and 7, Adobe Premiere Pro

Network Protocol SMB only

Access Control Users must be added to the Project Space to have access

User Operations Share project files (Avid only), Create Project (non-Avid only)

Administrator Operations Manage Shared Project Files Space

Contents Projects as organized by users 
Within a user’s view of each project: 
• Root
• User’s folder
• Other users
• Group Bins
• Unprotected bins (Avid) / Unprotected projects (non-Avid)

New Features Group Bins folder 
Project browser to help organize bins and project files

CHAPTER 5: METADATA SPACES
SHARED PROJECT SPACES

 88

When editors work together, the ideal workflow is that all editors can work 
simultaneously on the same metadata files, allowing them to instantly see what 
everybody else has created without having to copy files back and forth. In order 
to work collaboratively in this manner, you need to have a way to lock and 
manage project files so that one editor cannot overwrite the work of another. 

The EditShare Administrator creates one Shared Project Space for editors who 
need to work together. You can be a member of as many Shared Project Spaces 
as necessary. Like a Media Space, a Shared Project Space allows multiple users 
to view the same files simultaneously, but it is structured in a very special way 
designed to keep each editor's work safe. When you open up the work of Editor 
2, you have read-only access to Editor 2's work. You can see or copy what Editor 
2 has done. You can even edit Editor 2's clips or sequences directly into your 
own Timeline, but you can never modify Editor 2's work. 

EditShare blocks your workstation from creating media folders in any Shared 
Project Space. As with Private Files Spaces and Shared Project Spaces, it does 
not have enough room to create media files.

See the following topics:

• Folder Name Restrictions
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• "Shared Project Space Structure" on page 89

• "Using the Project Browser to Move Files" on page 91

• "Creating a Project Space" on page 92

• "Pop-Out Project Browser" on page 93

• "Working from Multiple Shared Project Spaces and Multiple Project 
Folders" on page 94

Folder Name Restrictions

Several folder names are restricted from Shared Spaces. These names are 
reserved for EditShare use. Do not name folders with any form of any of the 
following names (that is, any capitalization, spacing, hyphens, and so on):

• Statistics

• Group Bins

• Unprotected Bins

• Other Users

Shared Project Space Structure

When a project has been created in a Shared Project Space, it is given a structure 
that includes the following five special folders:

• Top-level (root) folder: The top-level folder you see inside a project is 
your private Space. You can create new files (Avid Bins, or Final Cut or 
Adobe Premiere Pro Project Files) in this folder and add and edit 
sequences, but nothing stored here is visible to other users.

• Your own user folder: Within your project is a folder named with your 
own username (for example, “avid1” or “allan”). Like the top-level folder, 
you can freely edit, organize, and delete bins or project files stored in this 
folder. Unlike the top-level folder, the contents of your user folder are 
visible, but not writeable, to other users. Other users can see what you are 
working on here, but they cannot modify or delete it.

NOTE:  If you want other users to see bins in a project you have shared, you need to 
move those bins into your user folder.

• Other Users folder: The Other Users folder contains one folder for each 
other user who is a member of the Shared Project Space. This is where you 
look when you want to see the bins and project files that other editors are 
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working on – and it is where they look to see your user folder. You can 
freely open files inside the Other Users folder, play back clips and 
sequences, and even include them in your own sequences, but you cannot 
edit them.

• Group Bins folder: The Group Bins folder is a place where all bins or 
project files are read-only to all users. You can move bins and project files 
in and out of the Group Bins folder using the Project Browser (see "Using 
the Project Browser to Move Files" on page 91), but while items are located 
in this folder, they cannot be modified by anybody. If you want to modify 
a bin or project file that's located here, you have to take it out and bring it 
to your own User Folder, then put it back when you are finished 
modifying it.

Group Bins allow you to organize Avid Bins or Final Cut Pro Projects by 
subject matter or some other criteria instead of organizing them by user. 
You might use this folder to store, for example, the bins or project files that 
refer to original captured clips that all users edit into their sequences, to 
logged daily rushes, or to common elements to be shared among many 
editors. You might also put finished rough cuts and fine cuts here so that 
everybody knows what's finished, and where to find it. Group Bins is the 
place where all editors can look to find items that are frequently needed by 
the entire group.

• Unprotected Bins (Avid) or Unprotected Projects (Final Cut): The 
Unprotected Bins and Unprotected Projects folders were designed for 
transferring ownership of bins between editors, but are no longer the best 
way to do this. Unprotected folders are readable and writeable by all 
editors. You can move a file into the Unprotected folder, and another user 
can move the file from the Unprotected folder into his own user folder, 
where he or she can edit it freely.

CAUTION:  Never work with bins or project files that are located in the 
Unprotected folder. Always move the file to your own folder first. Otherwise, it 
is possible that another editor might have the project file open at the same time, 
and whichever editor saves the project last overwrites the changes made by the 
other editor. In addition, some current versions of Avid do not allow you to save 
bins in the Unprotected Bins folder. 

EditShare recommends that you do not leave files in the Unprotected 
folder at all. Use it only as a temporary location for changing the 
ownership of a file from one editor to another, or not at all.

The Project Browser now offers a better way to transfer ownership of a bin 
between editors. As a result, the use of the Unprotected folder is no longer 
recommended. 
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Using the Project Browser to Move Files

The Project Browser tab in EditShare Connect helps you organize your Shared 
Projects. It provides an interface with your project, similar to that provided by 
Windows Explorer, the Macintosh Finder, or the Avid Bins window.

The following illustration shows project browsers with Avid Shared projects 
(left) and Final Cut Pro Shared projects (right).

The Project Browser gives you the ability to move bins and project files into and 
out of folders you do not normally have access to modify. You cannot move files 
into or out of other users' folders, or the Group Bins folder, except by using the 
Project Browser. After you move bins or files, or if you reverse the move by 
clicking Undo Give Away, you might need to click the Refresh button to see the 
result.

The Project Browser also offers a view of the entire Shared Project similar to the 
Avid Bins window to users whose NLE does not include such a view.



Moving bins or projects Procedure

Among folders you created 
at the top level of the project 
or your own user folder

Click the bin or project and then drag it to Windows Explorer, the Finder, Avid, or the 
Project Browser.

From the top level or your 
own user folder to another 
user’s folder

Click the bin or project and then drag it elsewhere in the Project Browser. If you accidentally 
drop the file into the wrong folder, click the Undo button within ten seconds to move the file 
back to its original location. This time limit prevents any loss of work should the editor to 
whom you gave the bin begin editing in it. The receiving editor might, of course, move the 
bin back into your folder the same way you gave it to him or her.

From another user’s folder to 
you own user folder

By default, you cannot do this. You must get the other user to move the file into your folder 
for you. However, the EditShare Administrator can give individuals the capability to move 
files from another user's folder. If you have been given this capability, drag and drop in the 
Project Browser. 

CAUTION:  Use extreme caution when you use this capability. While this does not destroy 
any work being done in the bin at the time it is moved, the new work is saved in an identi-
cally-named bin in the original editor's Shared Project Files, creating the potential for 
confusion and inconsistency.

Between the top level or 
your own user folder and the 
Group Bins folder

Drag and drop in the Project Browser.

Between the top level or 
your own user folder and the 
Unprotected Bins/ 
Unprotected Projects folder

Drag and drop in Windows Explorer, the Finder, Avid, or the Project Browser. 

NOTE:  Be careful – if another user is working with the file, you might accidentally cause there 
to be multiple copies, or overwrite their work.

Anywhere else Drag the file to your own user folder first and then to its desired location.
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See the following table for a summary of how to move bins or projects files in 
a project.

Creating a Project Space

To create a Project Space, do the following.

TASK

1. Open EditShare Connect and log in.
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2. Click the Projects tab. 

 

3. Click the New button, then select New Project to create a new project 
container within the Lockable Project. You must make a new project container 
in a lockable space before you can save Adobe Premiere Pro Project files in it.

 Check that you can save Adobe Premiere Pro projects in your project space. 
Launch Adobe Premiere Pro, create a new project, and save it in a location 
within the Editshare Shared Project space.

You can optionally make subfolders within the project container to organize 
your project files, for example, rough cuts, graphics, and so on.

The New Project dialog box opens.

4. Type a name for your project in the text box and then click OK. 

 The Project Name displays in the Project Browser.

5. Click OK to create the project.

Pop-Out Project Browser

You might want to use the pop-out EditShare Project Browser instead of the 
Project Browser tab built into EditShare Connect. The advantage of the pop-out 
browser is that you can resize it to fit nicely onto your screen among the other 
NLE windows.

To use the pop-out Project Browser, do the following.

TASK

1. Start EditShare Connect, and mount the Shared Project Space that contains 
the project you intend to work on.
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2. Click the Pop out button.

 The Project Browser opens.

3. Resize the Project Browser to proportions you like, and then create an NLE 
desktop around the Browser.

4. To copy project files or entire folders from your local machine to the EditShare 
Project Space, select File > Save Project As and navigate to the Shared Project 
Space where you want the file to be.

 A dialog box opens asking if you want to move the files or folders or if you 
want to copy them.

5. If you need a local copy, navigate to the Shared Project Space from your Finder 
and find the files or folders you need. 

 NOTE:  You cannot drag and drop objects out of the EditShare Project Browser 
and you cannot rename a project stored in a Shared Project Space.

Working from Multiple Shared Project Spaces and Multiple Project Folders

You can mount more than one Shared Project Space and work with more than 
one Shared Project folder. The EditShare Project Browser displays the contents 
of all Shared Project Spaces that are currently mounted on your workstation. 
Each Shared Project Space might contain multiple Shared Project folders. 
Clicking the Up arrow in the EditShare Project Browser until the display no 
longer changes reveals all Shared Project Spaces. Inside the Spaces are the 
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Shared Project folders, each with its own directory structure, organized for safe 
and easy Project Sharing.

Lockable Project Spaces

You can create a lockable Shared Project Space in which all files in a project are 
read-only (locked) until a user takes ownership of one. This can provide an easy 
way to share projects, particularly in smaller groups where you don’t mind other 
users working on your files.

When you take ownership of a file in a lockable Project Space, you can write to 
the file (unlocked to you) but it is locked to all other users. When you are done 
with that file, you can release it and another user can take ownership of it and 
write to it, locking it to all other users, including you.

NOTE:  This feature is for Final Cut Pro users and users of other non-Avid editing 
applications only.

To create and use a lockable Project Space, do the following.
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TASK

1. Create a lockable Project Space by doing the following:

a Log in as EditShare Administrator or ask your Administrator to carry out 
Steps b-f.

b Open the EditShare Manager in which you want to create a lockable 
Project Space.

c Click the Project Spaces tab.
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d Type a Project Space Name.

e From the Project Type list, select Lockable, and then click Add Project 
Space to System. 

 

f Add users and select other Project Space options.

2. Open EditShare Connect and log in.

3. Click the Projects tab.

 

4. Select your Lockable Project Space from the Project Space dropdown.
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5. Click New button, select New Project, type the project name in the New 
Project dialog box, and click OK.

 NOTE:  You must create a new project in the Lockable Project Space from within 
EditShare Connect.

6. Populate your project with the project files you want.

 In EditShare Connect, files that no one is using display a yellow Lock icon in 
the Status column. These files are locked (read-only) but available for any one 
user to unlock and write to.

A folder outlined in red, as in the Lunch folder in the preceding illustration, is 
for administrative use. You cannot write into that folder. You can write into 
projects represented by unmarked folders, as in the On the Wall folder.

7. To open a file for yourself and lock it for everyone else, click a yellow Lock icon.

 The icon turns green and displays as an unlocked padlock. In the following 
illustration, gguillotte is using the first two files in the project.

NOTE:  If you added all the files you are viewing, the icon displays open and green 
by default.

Files that someone else is using display a red Lock icon and the user’s name in 
the Owner column. The following illustration shows gguillotte logged in to 
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EditShare Connect, seeing the user jthompson’s ownership of projects 1 and 
2.

The following illustration shows gguillotte having taken ownership of a file, 
PanoramicView, that jthompson is not using.

jthompson’s view gguillotte’s view

NOTE:  The owner’s name appears in the Owner column.
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8. To relock all unlocked files when you logout of EditShare Connect, click the 
Settings tab and make sure Disown locked files on quit is selected (it is 
selected by default).

 

All files revert to unused (locked, available) status and display the yellow Lock 
icon to other users.

9. To leave all files you have taken ownership of in their current state, deselect 
the option.



Chapter 6: Acting as a Limited Administrator

In general, the EditShare Administrator is responsible for managing EditShare 
users and Media Spaces (see "Chapter 3: Getting Started as an Editor" on page 
19). However, sometimes the Administrator might choose to delegate certain 
management tasks for specific Media Spaces to other trusted users. For 
example, the editor in charge of a certain project might be given the capability 
to add users to Media Spaces for that project without needing to involve the 
Administrator. In some organizations, this can greatly streamline your 
workflow.

If you have been designated a limited administrator and granted these 
capabilities, you see a tab in EditShare Connect labeled Limited Admin. Click 
this tab to use the administrative functions the Administrator has allowed you 
to use.

See the following topics:

• Limited Administration by Media Space

• Limited Administrative Functions
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Limited Administration by Media Space

If you know which Media Space you want to work with, you can exercise limited 
administration by Media Space by doing the following.

TASK

1. Open EditShare Connect, and click the Limited Admin tab.

 

2. Select the Media Space you want to administer from the left pane.

3. Select the operation you want to perform. See "Limited Administrative 
Functions" on page 102.

Limited Administrative Functions

As a non-Administrator user, you can perform the following limited 
administrative functions through EditShare Connect.



Space Type Available Capabilities

Avid MXF, 
Managed, 
Universal

• Protect or Unprotect Media
• Change Read-only Mode
• Change Media Space Quota
• Enter or Leave Maintenance Mode
• Add Users to a Space
• Change Mac OS X Protocol*
• Remove Users from a Space
• Display Space Summary

Avid Style, 
Unmanaged

• Change Read-only Mode
• Change Media Space Quota
• Add Users to a Space
• Change Mac OS X Protocol*
• Remove Users from a Space
• Display Space Summary

Shared Project • Add Users to a Space
• Remove Users from a Space
• Take a Bin from Another User

System-wide • Add Media Space to System
• Add Shared Project Space to System
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NOTE:  Beginning with EditShare 7, it is now possible for a Limited Admin user to be 
granted the capability to change the Mac OS X network protocol for media spaces. 

Administrators should grant this capability with caution, because changing the OS X 
network protocol for a given space will delete all OS X resource forks in the space.

In general, most recent OS X applications do not store important information in resource 
forks, so deleting them is usually safe. However, some older applications, especially on 
Mac OS 9 or earlier, stored important file metadata in the resource fork, such as the file 
type, which could be lost if you use this feature.

Unless you are certain that you don't need any resource fork metadata, EditShare 
recommends that you back up your files before using this feature, or that you copy files 
via a workstation to a new space mounted by the protocol you prefer to use. You should 
also ensure no users are logged into any media space you are changing.



Chapter 7: Important Things to Know When 
Using EditShare with Avid

The following topics describe aspects of using EditShare with Avid applications:

• Setting up Avid Workstations

• Digitizing (Capturing) Media

• Avid Media Database Files

• Migrating Avid Media and Projects to EditShare

Setting up Avid Workstations

You need to do the following to configure your Avid workstation:

• Use the Avid Launcher. If you are on Windows and not using the Avid 
Launcher or you are on Mac and not using Avid Style Spaces, you need to 
use alldrives to enable Avid to see Avid MXF spaces. See "Enabling 
Avid Editing Systems to See Avid MXF Spaces" on page 54.

• Ensure that Filter Network Drives Based on Resolution is disabled in 
Avid. See "Disabling the Filter Network Drives Based on Resolution 
Option" on page 104.

• (Windows only) Disable Simple File Sharing. See "Disabling the Simple 
File Sharing Option (Windows Only)" on page 105.

• (Macintosh only) Decide if you will use DAVE or AFP. See "Using AFP or 
DAVE (Macintosh Only)" on page 116, “AFP” on page 116, “DAVE SMB” 
on page 116, “Considerations for Using AFP: Exporting QuickTime 
Movies” on page 116, and “Considerations for Using DAVE SMB 
(Macintosh Only)” on page 120.

• Make sure you are using Windows-compatible file names. See"Using 
Windows-Compatible Names" on page 122.

Disabling the Filter Network Drives Based on Resolution Option

To see network drives, you need to verify an option in the Avid application’s 
Media Creation dialog box.
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Depending on which version of Avid software you are using, Avid might enable 
Filter Network Drives Based on Resolution by default each time you create a 
new project. However, with filtering, the Avid editing application assumes that 
any media that is not on your internal “default media creation drive” has the 
wrong resolution (for example, that it is 1:1 instead of DV, or the opposite) so it 
filters out that drive. To prevent Avid software from filtering like this in the 
future, you should change your default preferences so that Filter Network 
Drives Based on Resolution is automatically deselected every time you create 
a project.

NOTE:  For detailed information about the Media Creation dialog box, see the Help for 
your Avid application.

To deselect Filter Network Drives Based on Resolution and change your default 
settings, do the following.

TASK

1. Start your Avid application and open a project.

2. Select Settings > Media Creation.

 The Media Creation dialog box opens.

3. Click the Drive Filtering & Indexing tab and deselect Filter Network Drives 
Based on Resolution.

4. Click OK.

5. Select File > Open Settings. 

6. Click the Up arrow and navigate to the next level of folders.

7. Double-click the Site Settings folder.

8. Click the Media Creation folder in the Avid Settings folder and drag it into the 
Site Settings folder.

9. Select File > Save Settings.

 Filter Network Drives Based on Resolution is deselected each time you start 
a new project in the future.

Disabling the Simple File Sharing Option (Windows Only)

For proper operation, Avid requires that you disable simple file sharing on your 
Windows workstation, whether or not you are using EditShare. With simple file 
sharing enabled, which is the Windows default setting, permissions settings on 
project files (bins, sequences, and so on) and Media Files are set incorrectly by 
your Avid editing software.

Incorrect permissions might not affect you immediately if you are working by 
yourself and storing all your files locally, but when you copy a project file or 
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media file from one place to another (for example, when you make a backup of 
your project file), you might be unable to open the copy even if you move it back 
to its original location. Similarly, if two users on your computer log in with 
individual usernames and try to access the same project files or media files, they 
receive instant “Access Violation” warnings.

At this point, even turning off simple file sharing won’t solve the problem for 
those files, because the permissions are already set incorrectly.

CAUTION:  When you are working with EditShare – which is designed for multiple 
users to share the same media files and project files – having simple file sharing set 
incorrectly causes major problems almost immediately.

See the following topics:

• "Disabling Simple File Sharing (Windows XP)" on page 106

• "Disabling Simple File Sharing (Windows Vista)" on page 107

• "Disabling Simple File Sharing (Windows 7)" on page 109

Disabling Simple File Sharing (Windows XP)

TASK

1. Click the Start button and select Settings > Control Panel.

2. Double-click Folder Options.

 The Folder Options dialog box opens.

3. Click the View tab.
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4. Scroll to the bottom of the Advanced Settings list.

 

5. Deselect Use simple file sharing (Recommended) and then click OK.

Disabling Simple File Sharing (Windows Vista)

TASK

1. Click the Start button.

2. Select Control Panel > Network and Sharing Center.

 The Network and Sharing Center window opens.
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3. In the Sharing and Discovery area, click the arrow next to File sharing.

 The File Sharing area opens.
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4. Select Turn off file sharing, and then click Apply.

 File sharing area is now disabled.

5. Close the Network and Sharing Center window.

Disabling Simple File Sharing (Windows 7)

TASK

1. Click the Start button.

2. Select Control Panel > Network and Sharing Center.

 The Network and Sharing Center window opens.
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3. In the Change your networking settings area, click Choose Home group and 
sharing options.

 The Change sharing options for different network profiles window opens.
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4. Click the check mark next to Home or Work.

 The Share with other home computers running Windows 7 window opens.
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5. Click Change advanced sharing settings in the left panel.

 The Advanced Settings window opens.
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6. Select Turn off file and printer sharing, and then click Save Changes.

 File sharing is disabled.

7. Close the Network and Sharing Center window.

Disabling Simple File Sharing (Windows 8)

TASK

1. Navigate to the Start screen.

2. Type “network and sharing center”, then press Enter.

 The Network and Sharing Center window opens.
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3. Click Change advanced sharing settings, and then click Apply.

 The Advanced Settings window opens.
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4. Select Turn off file and printer sharing, and then click Save Changes.

 File sharing is disabled.

5. Close the Network and Sharing Center window.
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Using AFP or DAVE (Macintosh Only)

You can use Apple Filing Protocol (AFP) or some form of Windows networking 
(SMB) to connect your Macintosh Avid to any network storage, including 
EditShare.

AFP

AFP is the traditional network protocol used by Mac OS X for connecting to 
other Macintosh computers over the network. EditShare recommends that 
editors connect to EditShare by AFP if possible. AFP should provide the best 
stream counts and smoothest experience with Avid. 

NOTE:  AFP is not compatible with the Edit While Capture feature of the EditShare Flow 
and Geevs Ingest Servers. If you work with Edit While Capture, you must use SMB.

DAVE SMB

DAVE is a third-party product that replaces the Native SMB client built into 
Mac OS X. It provides the fastest, smoothest, and most robust SMB access to 
media stored on an EditShare server. Using Avid with the Apple Native SMB 
client became impractical starting with Avid Media Composer Version 2.7.3. As 
of that version, Avid could no longer capture or render to any network storage 
mounted by the Apple Native SMB client. 

Note:  Read-Only access to Avid spaces is still possible using the Native SMB protocol. 
However, it is very important that Read/Write users never access a space by more than 
one protocol, as that produces a mixture of different types of resource forks. See “Hiding 
Mac Resource Forks” on page 30 for more information. The best policy is to not use 
Native SMB. 

You can purchase DAVE licenses directly from EditShare. In addition, since 
Thursby releases occasional new releases of its product, EditShare can advise 
you on the best version of DAVE to use as of the time you call. See the latest 
ReadMe on the EditShare web site for recommendations about which DAVE 
version to us.

Considerations for Using AFP: Exporting QuickTime Movies

Avid applications running on OS X can have trouble exporting QuickTime 
movies to AFP-mounted Media Spaces. Don’t confuse Exporting with 
rendering effects or consolidating. Exporting refers specifically to creating a 
new self-contained QuickTime movie from a clip or sequence. The limitation 
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on exporting seem to be related to whether or not the application is using legacy 
32-bit QuickTime libraries or newer 64-bit QuickTime libraries. 

When you export from Avid Media Composer v6 and v7 and create a movie file 
larger than 2 GB, if you click Same as Source in the export settings as shown in 
the following illustration, the export always stops at 2 GB (sometimes reported 
as 2.15 GB in Finder). 
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If you are creating a short movie smaller than 2 GB, you can select Same as 
Source. However, it is really only appropriate to click Same as Source when all 
of your material has been captured in a single codec. If your movie will be larger 
than 2 GB and/or if you have source material created in many different codecs, 
EditShare recommends that you select Custom as shown in the following 
illustration.
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When you select Custom in your export settings, you must configure both the 
Video and the Sound format settings. Clicking Settings in the Video area opens 
up the following configuration screen, where you can choose the codec you 
want for your export, including DNxHD, ProRes, H.264, or other codecs. 
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You also have to set the Audio format when you export with custom settings. By 
default, Avid sets the export to 44 kHz audio, but you might want to keep the 
audio at 48 kHz to avoid having to resample the audio and to preserve 
maximum quality. See the following illustration.

Considerations for Using DAVE SMB (Macintosh Only)

When you connect to any kind of EditShare Avid space, including Avid Style, 
Avid MXF, and Avid Shared Project spaces, be sure to use the correct DAVE 
version for your Mac OS X version.

Table 1: Recommended and required DAVE versions for OS X

OS X Version DAVE v8.1
DAVE v9.0.2 

build 1450 DAVE v10.0.0 DAVE v10.0.x DAVE v11.0.x
Mavericks (OS X 10.9) Incompatible Recommended
Mountain Lion (OS X 10.8) Incompatible Minimum Compatible Recommended
Lion (OS X 10.7) Incompatible Minimum Compatible Compatible Recommended
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NOTE:  Always check the EditShare updates page (http://www.editshare.com/updates) for 
the latest information on DAVE. 
 
While DAVE v11.0.1 is the latest approved version of DAVE as of the publication of this 
guide, EditShare and Thursby are constantly improving DAVE, so there might be a newer 
approved version by the time you read this document. All DAVE upgrades are free within 
the current product version, such as updates within point releases like DAVE v9.0 to 
DAVE v9.0.2. Upgrades to a new product version, such as from v8 to v9, are paid. Contact 
Thursby Software Systems for upgrade information or visit 
http://www.thursby.com/purchase/upgrades.html to handle your upgrade online.

See the following sections:

• "Special Note on DAVE v9.0.2 build 1450 and DAVE v10" on page 121

• "Mountain Lion (OS X 10.8)" on page 122

• "Lion (OS X 10.7)" on page 122

• "Snow Leopard (OS X 10.6)" on page 122

Special Note on DAVE v9.0.2 build 1450 and DAVE v10

DAVE v9.0.2 build 1450 introduced many bug fixes, performance 
enhancements, and feature enhancements that directly benefit EditShare users, 
and DAVE v10 includes those improvements and more. 

All Snow Leopard users should install DAVE v9.0.2 build 1450 or DAVE 
v10.0.1.

DAVE v9.0.2 build 1450 can be installed with any DAVE v9.x license. If you 
purchased a DAVE v9 license directly from EditShare, you may be eligible for a 
free upgrade to DAVE v10. Go to http://www.thursby.com/upgrades/dave/ to 
obtain upgrade keys and the DAVE v10 installer.

Mavericks (OS X 10.9)

Thursby Software Systems only supports DAVE v11.0.x on OS X Mavericks 
(10.9).

CAUTION:  If you are upgrading your OS, you must first uninstall DAVE before 
upgrading. If you don’t first uninstall DAVE, you cannot properly install or run DAVE 
v11 on the newer version of OS X without contacting Thursby Software Systems Technical 
Support or reimaging your system.

Snow Leopard (OS X 10.6) Minimum Compatible Incompatible Recommended Incompatible
OS X Version DAVE v8.1

DAVE v9.0.2 
build 1450 DAVE v10.0.0 DAVE v10.0.x DAVE v11.0.x

http://www.editshare.com/updates
http://www.thursby.com/purchase/upgrades.html
http://www.thursby.com/upgrades/dave/
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Mountain Lion (OS X 10.8)

Thursby Software Systems supports DAVE v10.0.x and v11 on OS X 
Mountain Lion (10.8).

CAUTION:  If you are upgrading your OS, you must first uninstall DAVE before 
upgrading. If you don’t first uninstall DAVE, you cannot properly install or run DAVE 
v11 on the newer version of OS X without contacting Thursby Software Systems Technical 
Support or reimaging your system.

Lion (OS X 10.7)

Thursby Software Systems supports DAVE v9, v10, and v11 on OS X Lion 
(10.7). EditShare requires DAVE v9.0.2 build 1450 or newer.

EditShare recommends DAVE v11.0.x on Lion, and at least DAVE v10.0.x, if 
your workstations will also run recent versions of Adobe Creative Suite, as 
DAVE v10.0.x and newer resolve error messages that appear when saving files 
under DAVE v9.0.x.

CAUTION:  If you are upgrading your OS, you must first uninstall DAVE before 
upgrading. If you don’t first uninstall DAVE, you cannot properly install or run DAVE 
v11 on the newer version of OS X without contacting Thursby Software Systems Technical 
Support or reimaging your system.

Snow Leopard (OS X 10.6)

DAVE v9.0.2 build 1450 and DAVE v10.0.1 are recommended by EditShare for 
use with OS X Snow Leopard (10.6.x) because they resolve many important 
issues in Snow Leopard that were never resolved in the DAVE v8 series.

On Snow Leopard, you must use DAVE v10.0.1, as it contains an important fix 
related to password handling when updating from earlier versions of DAVE or 
OS X.

Thursby does not support DAVE v11 on OS X Snow Leopard.

Using Windows-Compatible Names

Even if your organization uses nothing but Macintosh OS X, EditShare requires 
you to name your files with Windows-compatible names. In Avid, you need to 
select the Use Windows Compatible Names option. For information about 
where to locate this option, see the Help for your Avid application. In addition, 
you should not use non-alphanumeric characters (that is, *?/.-_!#%) in file 
names.
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Digitizing (Capturing) Media

When you digitize (capture) media, you need to direct Avid to put the media 
into the desired Avid Style or Avid MXF Media Space on your EditShare server, 
not on your local hard drive (which no other users can see) or in the Avid 
Shared Project Space (which does not have enough room for media). EditShare 
blocks your Avid application from creating media folders in any Project File 
Space. 

On Windows workstations, EditShare suggests mapping your most-used Media 
Space so that it appears as drive Z. If you connect to more than one Media Space 
simultaneously – for example, if your project has more than one Media Space 
associated with it, such as one for captured media and one for rendered effects 
– be careful to put your media onto the correct drive. 

On Windows, unless you run Avid Launcher, Avid only shows you the drive 
letter that you have mapped to the Media Space and not the full name. If you 
forget which EditShare Media Space corresponds to which drive letter (for 
example, if you’ve captured into Drive Z: and rendered effects into Drive Y:), 
you can always check in EditShare Connect to see the full name of your 
mapped drives.

See the following topics:

• "Selecting an EditShare Space on Macintosh OS X (Macintosh Only)" on 
page 123

• "Managing Avid Media Files" on page 124

• "Managing the Avid Media Database" on page 125

Selecting an EditShare Space on Macintosh OS X (Macintosh Only)

To select an EditShare Shared Project Space in which to save your Avid project 
when you are working on a Macintosh OS X system, do the following.

TASK

1. Start your Avid editing application.

2. Click the folder icon on the right side of the Select Project dialog box.

 The Project Directory dialog box opens.
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3. Select your network volume or select your computer and then navigate to 
your network volume.

4. Select your mounted Shared Project and then click Open.

5. In the Avid application, select a destination for your media files.

 EditShare Spaces, including Media Spaces, automatically appear in the list of 
possible drives in the Media Creation dialog box and the Capture tool.

Managing Avid Media Files

Compared to managing metadata files, managing media files is simpler. You 
only need to store captured files in an Avid MXF Media Space for the project.

You should also review the special considerations described in "Managing the 
Avid Media Database" on page 125.

To manage your media files in your Avid application, do the following.

TASK

1. Connect to the Media Space you want.

2. (Windows only) Map the Media Space to a drive letter, for example, Z.
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3. Select the Media Space in the Avid Capture tool as follows:
• (Windows) By drive letter

• (Mac) By name

Managing the Avid Media Database

It is a known Avid issue that the Media Database files created by Avid editing 
applications are vulnerable to corruption as they grow larger. When a Media 
database file gets too large, the Avid application noticeably slows down, and 
eventually the database file becomes corrupted. 

For this reason, Avid officially recommends storing no more than 5,000 media 
files in any given storage volume or Media Space. In fact, Avid applications 
normally create a new MXF subfolder once you reach 5,000 files in any single 
folder. 

EditShare concurs that all users should follow these guidelines. To help you, 
EditShare monitors all Avid Media Spaces and sends the EditShare 
Administrator a warning email when the number of files in a folder might be 
growing too large. 

A few tips on how to keep a smaller number of files in each Media Spaces are as 
follows:

• Don’t break tapes into hundreds of master clips – use subclips instead. 
Many users are accustomed to a workflow where they log their tapes 
before capturing, and then capture the tapes in dozens or hundreds of 
small clips. Unfortunately, this workflow results in creating dozens or 
hundreds of files for each tape – at least 3 files (one video, two audio) for 
each master clip.

To reduce the number of files you create, EditShare recommends NOT 
logging tapes before you capture them. Instead, you can capture each 
entire tape as a single clip. A complete one-hour DV 25 tape might be 
captured in just 8 files (6 video plus 2 audio). If the tape has a few timecode 
breaks, you might end up with 20 or 30 files. But the number of files 
should be much lower than if you capture a tape in hundreds of small 
master clips.

After capturing an entire tape as one or a few master clips, your loggers or 
assistant editors can break down those master clips into an unlimited 
number of subclips, and give each subclip a useful name that is visible 
when you edit the subclip into your Timeline. Creating subclips doesn’t 
create any additional media files.
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• Put rendered files in their own Media Space. Creating a separate Media 
Space for storing rendered effects further reduces the risk of accumulating 
too many files. Consider creating a “Render Space” for each project. This 
can also avoid a problem some Avid users have observed where certain 
types of render files can cause a media database to grow unexpectedly 
large (hundreds of megabytes in size) and become easy to corrupt and 
difficult to rebuild.

Avid has confirmed that this problem has nothing to do with EditShare, 
and in fact, using EditShare to keep your rendered files separate from 
captured media files helps protect you from this problem. If you become 
unable to rebuild the media database with rendered files, you can delete 
the rendered Media Space and rerender what you need without losing 
your captured media files.

Avid Media Database Files

One of the reasons Avid NLE software is so powerful and robust is that Avid 
programs create a media database in every media folder on every drive. These 
databases contain essential information about each clip in that folder – the tape 
name or number, the clip name, the media files that make up that clip, and so 
on. Even when drive names or letters change, Avid NLEs know exactly which 
files are where simply by reading the database in each folder. Avid doesn't need 
to actually look at the files themselves once the database has been created.

When working with a local drive, you are largely unaware of the media database 
files. Every time you capture or delete a clip, Avid automatically updates the 
media database at the moment the clip is captured or deleted. 

However, if clips are copied or moved from one drive to another outside of an 
Avid application (for instance, if you are combining clips from two drives), 
when Avid is restarted, all new media files are detected and scanned and the 
database files are then be updated to reflect the new additions. 

If there are only 10 or 20 new clips, scanning the files and updating the database 
takes just a few seconds. But if thousands of new clips are added to a drive, 
scanning can take several minutes. If clips have been deleted from a media 
folder outside of the Avid program, when you start the program again, Avid 
must rebuild the database from scratch, because it doesn't know which files have 
disappeared.

See the following topics:

• "Media Databases and Avid MXF Media Spaces" on page 127
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Media Databases and Avid MXF Media Spaces

In Avid MXF Media Spaces, each user captures and renders files into his or her 
own numbered subfolders of the MXF folder. This design ensures that each 
folder's media database is always kept in sync with the media files in that folder, 
thus avoiding the need for frequent rescanning and updating of the databases as 
new files are added by other users.

Migrating Avid Media and Projects to EditShare

You can migrate your Avid media and projects to EditShare. You should first do 
the following:

1) Select projects you want to migrate to the EditShare server.

2) Organize the media in terms of the project it belongs to. Keep projects 
separate that are owned by different clients, or projects covering different 
subject matter. This facilitates editors knowing which Media Spaces to 
mount, which media can be moved or deleted, and where the 
media resides.

3) Decide on a schema: post-production houses might create a Media Space 
for each job, while a news facility might organize by dates or subject 
matter, for example, features, interviews, headlines, and so on.

4) Create the Media Spaces you need. Make sure that no more than 5000 files 
go into any individual numbered folder inside Avid MediaFiles/MXF/.

You then consolidate or relink the media to EditShare, and migrate the Avid 
project files to a Shared Project Space.

NOTE:  Consolidating copies only the media actually used in the selected clips and 
sequences, and omits media files or parts of media files that are not referred to. If you are 
transferring a project to EditShare that you are still actively working on, you might want 
to relink your files rather than consolidate them.

See the following topics:

• "Consolidating Avid Media to EditShare using the Consolidate/Transcode 
Tool" on page 128

• "Relinking Avid Media to EditShare" on page 129

• "Migrating Avid Project Files to a Shared Project Space" on page 130
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NOTE:  If you have existing OMF media you want to transfer to EditShare, EditShare 
recommends transcoding it to MXF so you can use the Avid MXF Media Space rather 
than a Traditional Avid Media Space.

Consolidating Avid Media to EditShare using the Consolidate/Transcode Tool

To move all and only the media connected to a single Avid project, do the 
following.

TASK

1. Start the Avid editing application, and open the project.

2. Select the clip or clips you want.

3. Select Clip > Consolidate/Transcode.

 The Consolidate/Transcode dialog box opens. For detailed information, see 
“Using the Consolidate Command” in the Avid editing application Help.
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4. Select the Consolidate option in the upper left corner.

5. In the Target Drive(s) area, select the relevant Media Spaces.

6. Select Skip media files already on the target drive.

7. Click the Consolidate button in the lower right corner.

 The Copying Media Files dialog box opens.

8. Select Relink Master clips to media on the target drive, and then click OK.

 The application creates new media files and new clips that are linked 
according to your selection. Make sure that no more than 5000 files go into 
any one folder.

9. Disconnect the drive from the editing application by doing the following:
• If the drive is internal, rename the Avid MediaFiles folder to Avid Media-

Files.old.

• If the drive is external, unmount it and detach if from the editing appli-
cation.

10. Check the project for offline media.

Relinking Avid Media to EditShare

An alternative to using the Consolidate/Transcode tool is to do the following.

TASK

1. Navigate to the Avid media in Windows Explorer (Windows) or the Finder 
(Macintosh), and copy it to the Media Space you want on the EditShare server.

2. Start the Avid editing application.

3. Select the clip or clips you want.
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4. Select Clip > Relink.

 The Relink dialog box opens. For detailed information, see the Avid editing 
application Help.

5. Select options as described in “Relink Options” in the Help and then click OK.

Migrating Avid Project Files to a Shared Project Space

You can migrate Avid projects to an Avid Shared Project Space on EditShare. 
Do the following.

TASK

1. Make sure your Avid project is in the usual structure, and that you are not 
using any restricted names. 

 For more information on EditShare name restrictions, see "Folder Name 
Restrictions" on page 89. In addition, do not use the following words in folder 
names:

• OMFI

• Avid MediaFiles

• Capture Scratch

• Audio Capture Scratch

• Render Files

In addition, do not use any of the following file name extensions: 

.omf, .mxf, .wav, .avi, .mpg, .mov, .aif, .mp3

2. Copy the project to an Avid Shared Project Space.

3. Start EditShare Connect, and click the Avid Management tab.

4. Click Update this Page.

5. In the Share Avid Project area, select the project, and then click Share.

 The project is now migrated to EditShare.
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For information about configuring and using Final Cut Pro 6 and 7, see the 
following topics:

• Getting the Best Network Performance

• Configuring Final Cut Pro 6 and 7

• Sharing Final Cut Pro 6 and 7 Projects

• Sharing Final Cut Project Data by Trading XML Files

• Migrating Final Cut Pro 6 and 7 Media and Projects to EditShare

• Common Issues with Final Cut Pro 6 and 7

Getting the Best Network Performance

Final Cut Pro 6 and 7 are generally less tolerant of network latency than Avid 
applications. Getting the best performance when editing using network storage 
can require a little more attention to detail when you are setting up your 
workstations. Consider the following:

• EditShare recommends that Macintosh OS X users mount their EditShare 
Spaces using AFP (Apple Filing Protocol) or the Third Party DAVE SMB 
(Windows Networking) client. The “Native SMB” client (the one that 
comes with OS X) does not offer sufficient reliability or performance and 
should generally be avoided. AFP will give you the best performance 
under most circumstances. However, you should not use AFP if either of 
the following apply: 

– You use the FCP 6 or 7 Log and Capture tool to capture video files 
in any of the DV formats (DV25, DV50, DVC Pro HD). This 
includes capturing via FireWire or SDI. When you connect by AFP, 
captured files larger than 2 GB end up with an invalid timecode 
track, and thus all clips appear to begin at 00:00:00:00. This is due to 
a bug in Apple’s 32-bit QuickTime libraries. Other formats such as 
IMX 50, Uncompressed, all ProRes formats, XDCAM EX, XDCAM 
HD, and AVC-intra are not affected.



CHAPTER 8: USING EDITSHARE WITH FINAL CUT PRO 6 AND 7
CONFIGURING FINAL CUT PRO 6 AND 7

 132

– You use EditShare’s Edit While Capture (EWC), a feature that is 
included with Flow and Geevs Ingest. EWC allows you to begin 
playing and editing clips as soon as recording starts but it is currently 
incompatible with AFP.

• Playback performance is generally better with jumbo frames enabled. See 
the EditShare Administrator’s Guide for more information.

Configuring Final Cut Pro 6 and 7

See the following topics about configuring Final Cut Pro 6 and 7:

• "Waveform Cache and Thumbnail Cache" on page 132

• "Auto Save Vault" on page 132

• "Choosing a Media Space as your Scratch Disk on OS X" on page 133

• "Saving Final Cut Pro 6 and 7 Settings" on page 133

Waveform Cache and Thumbnail Cache

When you select where to put the media files that you are capturing (setting 
Capture Scratch), EditShare recommends that you do not store your waveform 
cache or thumbnail cache files inside an EditShare Media Space. Since these files 
are generally quite small, and are created automatically and quickly by Final Cut 
Pro, there is virtually no value to sharing them with other editors. It is better to 
store them on your local hard drive.

Auto Save Vault

Do not set Final Cut Pro to store your Auto Save files on the EditShare server. 
The Auto Save Vault must be stored on your local hard drive.

Choosing a Media Space Type

You can use Managed or Unmanaged Media Spaces (for details on Media 
Spaces types, see "Types of Media Spaces" on page 38). EditShare does not advise 
using Traditional Final Cut Media Spaces.
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Choosing a Media Space as your Scratch Disk on OS X

To choose an EditShare Media Space as a Scratch Disk in Final Cut Pro on OS X, 
do the following.

TASK

1. Follow the procedure in "Preparing OS X Workstations (Macintosh Only)" on 
page 20.

2. Open Final Cut Pro, and then select Final Cut Pro > System Settings > Scratch 
Disks.

3. Click Set.

 The Choose a Folder dialog box opens.

4. Select Devices > YourComputerName.

 

5. Select the Media Space you want to use for capturing and rendering.

Saving Final Cut Pro 6 and 7 Settings

EditShare Connect allows Final Cut Pro 6 and 7 settings such as Capture Scratch 
folder, auto-render settings, and window layout to travel from workstation to 
workstation with each editor, just like their Media Spaces and projects do. This 
feature works with Final Cut Pro v5 and later.
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You should use some discretion when restoring saved Final Cut Pro settings to 
a workstation you don't normally use. Even if everyone in your organization is 
in the habit of saving their settings on the server, there might be specialized 
workstations on which your usual settings would be inappropriate. For 
example, if you normally work on an editing workstation with two large 
monitors, and you temporarily log in on a laptop to give a screening, you might 
not want your usual settings there. And if not all editors are using this feature, 
it's possible that an editor might be upset to find that you have changed his or 
her settings. Your EditShare Administrator should help determine how your 
organization uses this feature.

To save your Final Cut Pro settings, do the following:

TASK

1. Close Final Cut Pro.

2. Open EditShare Connect.

3. In the Final Cut Pro settings area of the EditShare Connect window, click Save.

4. (Option) To restore previously-saved Final Cut Pro settings to the workstation 
you are using, click Restore, and then start Final Cut Pro.

 Any settings that might have been on the workstation previously are copied 
to a backup file located in the same place as the actual settings file: 
~/Library/Preferences/Final Cut Pro User Data.

Sharing Final Cut Pro 6 and 7 Projects

Final Cut Pro 6 and 7 stores all of its metadata for each project in a single project 
file. Whenever you first save a new project with your Final Cut Pro application, 
Final Cut creates the project file in the place you specify in the Select Project 
window, with the name you gave to the project. By default, Final Cut Pro stores 
these on your local drive in the /Users/name/Documents/Final Cut Documents 
folder, but you can override the default and store them wherever you want – 
including in an Shared Project folder in an EditShare Final Cut Shared Project 
Space, which allows you to collaborate with other users, or in your Private Files 
Space, which allows you to access your project from any server you might log 
into, while keeping it private for your use only.

The project file does not contain any media clips. It contains only metadata 
which refers to the media clips stored elsewhere, for example, in an EditShare 
Media Space. 

You can store your Final Cut project files on a local hard drive and have the 
media files on EditShare, but project files stored on a local hard drive are only 
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accessible from that workstation. You can instead create a project inside your 
Private Files Space on the EditShare server, and save your project files there 
instead of on your local hard drive. This way you can access your project from 
any server you might log in to, but it remains private for your use only.

Two methods for collaborating on a Final Cut project with other users are as 
follows:

• You can use Final Cut Shared Project Spaces (see "Project Sharing with 
Final Cut Pro 6 and 7, Adobe Premiere Pro, and Other NLEs" on page 85). 
This allows multiple Final Cut Pro editors to work simultaneously on the 
very same metadata files without danger.

• You can collaborate on a project stored on your local hard drive on in your 
Private Files Space by exporting Final Cut bins as XML files which can be 
imported by other editors into their projects.

NOTE:  You might experience intermittent “Unknown File” errors if you try to save your 
Final Cut Pro project file (projectname.fcp) to your EditShare shared project space. This 
is a Final Cut Pro limitation. Save your project file to the local hard drive on your Mac, 
close Final Cut Pro, and use the Finder to copy the project file back to the EditShare 
shared project space.

See the following topics:

• "Differences between DAVE SMB and Native SMB" on page 135

• "Project Organization Tips" on page 135

• "Sharing Final Cut Project Data by Trading XML Files" on page 140

Differences between DAVE SMB and Native SMB

In addition to the better performance provided by DAVE SMB, DAVE also 
provides superior handling of permissions information provided by the server. 
If you are using DAVE SMB and you open a project file from another user's 
folder or the Group Bins folder, you see a warning that the project is read-only. 
When you are using Native SMB, this warning is not offered, so you are more 
likely to accidentally spend time working on sequences stored in a project file 
that you cannot then save.

Project Organization Tips

The following tips should help you with organizing project sharing in Final Cut 
Pro:



CHAPTER 8: USING EDITSHARE WITH FINAL CUT PRO 6 AND 7
SHARING FINAL CUT PRO 6 AND 7 PROJECTS

 136

• If you are working on a big project with hundreds of digitized tapes, it 
probably makes sense to make a few master projects that have all of the 
logged clips and subclips, and then make a new project for each scene or 
sequence that an editor might work on. For example, if you shot 300 tapes 
for a project, you might create one master project called Tapes 1 to 100, 
another called Tapes 101 to 200, a third called Tapes 201 to 300, and then 
perhaps a fourth master project called Music and Graphics Library. Once 
you have populated those projects with raw material, you would rarely 
change them except to add more material. Most editors only open those 
master projects to get access to the logged clips and subclips and copy 
them into a smaller Project.

You then create new Project Files for each new sequence you work on. So 
for instance, you might have one Project called Opening, another called 
Act 1, another called Act 2, and so on (using more descriptive names than 
Act 1 and Act 2). Normally, the editor working on a particular sequence 
needs to have the project file corresponding to it within his or her own 
user folder, so that changes can be saved.

• When you start a new sequence, consider creating two new Projects: one 
for the raw material that you copy in from master projects to use when 
editing the sequence, and one for the actual sequence. Having just the raw 
material you need means it won't be necessary to open a large master 
project to do your editing (which can save time opening the Project in the 
future and can save system memory). Remember, when you copy clips and 
subclips in from another Project, you are not duplicating any media files. 
You are only duplicating references to those files.

Once you have the clips and subclips needed for the sequence, there is no 
reason to keep the master projects open. The fewer references to clips you 
have open, the better your editing application works.

• When you create revised versions of the sequence, consider moving older 
versions of the sequence into a separate Project file, perhaps named 
something like, Sequence Name – Old Versions. This way, Final Cut Pro 
does not have to open all the old versions of your sequences when all you 
want to see is the latest versions.

• To keep clutter to a minimum, consider creating subfolders within your 
own user folder.

• If you need to make copies of a Final Cut Pro Project File or Avid bin or 
sequence because you want to make changes to it, and it resides in 
somebody else's folder, be sure to give the copy a name that says what 
version of the Project file or bin it is. For instance, include your name and 
the date so that other editors know it's not the original or main version of 
the Project file or bin.
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Migrating Final Cut Pro 6 and 7 Media and Projects to EditShare

You can migrate your Final Cut Pro media and projects to EditShare. You 
should first do the following:

1) Select projects you want to migrate to the EditShare server.

2) Organize the media in terms of the project it belongs to. Keep projects 
separate that are owned by different clients, or projects covering different 
subject matter. This facilitates editors knowing which Media Spaces to 
mount, which media can be moved or deleted, and where the 
media resides.

3) Decide on a schema: post-production houses might create a Media Space 
for each job, while a news facility might organize by dates or subject 
matter, for example, features, interviews, headlines, and so on.

4) Create the Media Spaces you need.

You then consolidate or copy the media and projects to EditShare. See the 
following topics:

• "Consolidating Final Cut Pro Media to EditShare" on page 137

• "Copying Final Cut Pro Media to EditShare by Reconnecting" on page 139

• "Migrating FCP Project Files to a Shared Project Space" on page 139

Consolidating Final Cut Pro Media to EditShare

To consolidate FCP media to EditShare, do the following.

TASK

1. Start Final Cut Pro, and select the clips you want to transfer.

2. Select File > Media Manager.

 The Media Manager dialog box opens.
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NOTE:  For detailed information on the Media Manager tool, see your 
Final Cut Pro documentation.

3. In the Media area, select Copy.

4. In the Media Destination area, click Browse, and then navigate to the 
EditShare Media Space you want.

5. Click OK.

 The Save dialog box opens and you are asked for a location in which to store 
the project file. You can store the project file in the same location as the media, 
in your Private Files Space, or in a Shared Project Space.

6. Specify a location, type a name for the project, and then click Save.

 The project is created and the media is copied.

7. Disconnect your source media drives, and then make sure that the media you 
need was transferred.



CHAPTER 8: USING EDITSHARE WITH FINAL CUT PRO 6 AND 7
MIGRATING FINAL CUT PRO 6 AND 7 MEDIA AND PROJECTS TO EDITSHARE

139

Copying Final Cut Pro Media to EditShare by Reconnecting

An alternate way to transfer your media is to copy it and then reconnect the 
media. Do the following.

TASK

1. Select your media folder on the source disk.

2. Mount the Media Space on a Macintosh workstation.

3. Copy the folder to a Media Space on EditShare by dragging it and dropping it 
in the Finder (or use any other method you want).

4. Start Final Cut Pro, and select the clips you copied. 

5. Select File > Reconnect Media

 The Reconnect Files dialog box opens.

NOTE:  For more information on the Reconnect Media option, see your Final Cut 
Pro documentation.

6. Click Locate.

 The Reconnect dialog box opens.

7. Navigate to your EditShare Media Space and select the files you copied.

8. Click Choose.

 The Reconnect Files dialog box reopens, and the files you located are in the 
Files Located area.

9. Click Connect. 

 The copied files are reconnected.

10. Make sure the files you want are successfully transferred.

Migrating FCP Project Files to a Shared Project Space

You can migrate FCP projects to an Final Cut Shared Project Space on 
EditShare. Do the following.
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TASK

1. Make sure you are not using any restricted names. 

 For more information on EditShare name restrictions, see "Folder Name 
Restrictions" on page 89. In addition, do not use the following words in folder 
names:

• Capture Scratch

• Audio Capture Scratch

• Render Files

In addition, do not use any of the following file name extensions: 

.omf, .mxf, .wav, .avi, .mpg, .mov, .aif, .mp3

2. Create a Final Cut Shared Project Space.

3. Copy the project to the shared folder of the Shared Project.

Sharing Final Cut Project Data by Trading XML Files

When you are using Final Cut in the traditional way, where all of your bins and 
sequences for a project are stored in a single project file, you can still export 
individual bins as XML files which can then be imported by another user into 
their application. This is the procedure Final Cut editors have used in the past 
for collaborating with other editors. Shared Project Spaces are generally a more 
efficient way of working collaboratively, but the traditional techniques still work 
for those who choose to use them.

You can also apply the following procedure to sharing newly digitized or 
captured clips. Although other editors would be able to find those clips simply 
by browsing available clips and importing them into their Final Cut project, it 
might be much easier to locate newly digitized or captured clips if the person 
who created them puts an XML copy of the clips into the Shared Project Files 
area. The .xml file might be called john new clips march 15.xml and anybody 
would know that this file contains references to the clips that John captured on 
March 15. 

NOTE:  Only the metadata about the clips is being copied in this procedure, not the media 
itself. A single copy of the media remains in the Media Space, accessed by all editors.

The key to successfully sharing project data is to devise a naming system that 
works for your particular situation and workflow. If you share bins frequently, 
you might find it helpful to establish rigorous conventions for how to name 
sequences and XML files and where to put them in a File Exchange Space, so 
that everyone can easily identify locate the latest sequences or captured clips. 
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Although sequences also contain information about when they were created 
and modified, it's easier if the name of the sequence gives some idea about who 
made it and when.

To trade XML files, do the following.

TASK

1. Create a project and capture media into a Media Space.

2. Create sequences in one or more bins.

 It can be helpful to copy specific items into one bin you’re going to share, 
naming it clearly.

3. Save the bin you want to share.

4. Share the Media Space into which you captured the media, and make sure the 
other editor refreshes his or her Space. See "Sharing and Refreshing Media 
Spaces" on page 168.

5. Select the new bin, and then select File > Export to export the selection as an 
XML file into one of the File Exchange Spaces on the EditShare Server. 

 NOTE:  Make sure you put the XML file into a clearly labeled folder to help keep 
this space organized. Also, you can skip the bin step and export a rough cut 
sequence as XML.
 The other editor now selects File > Import to import the XML file into his or 
her Final Cut Pro application, and then opens the clips and sequences.

6. Delete the bin from the File Exchange Space on EditShare when it’s clear that 
nobody else needs a copy.

 NOTE:  The other editor can also delete the XML file.

Common Issues with Final Cut Pro 6 and 7

Be aware of several common issues with Final Cut Pro. See the following topics:

• "Avoiding Timecode Loss with DV" on page 142

• "Managing Render Files" on page 143

• "Rendering to the Wrong Drive" on page 143

• "Strategies for more Reliable Output" on page 143

• "Avoiding Dropped Frames with Longer DV 25 Clips" on page 144
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Avoiding Timecode Loss with DV

When you are using Final Cut Pro to capture DV 25, DV 50, or DVCPRO HD 
media to any network drive (including an EditShare Media Space), the timecode 
data might be lost if the media file grows larger than 2 GB. This is a limitation 
of Final Cut Pro, not of EditShare. The same thing happens when capturing files 
to another Macintosh OS X workstation over the network. The problem occurs 
whether you are capturing via FireWire or using a capture card such as a 
Decklink or Kona. 

There are several ways to avoid this problem:

• Use AFP or the EditShare-recommended DAVE version to connect to 
EditShare, instead of Apple's native SMB client (see your EditShare 
Administrator). Recent versions of DAVE allow Final Cut Pro to capture 
DV 25, DV 50, and DVCPRO HD files over 2 GB in size to a network drive 
without losing the tape name and timecode data.

• If you are capturing through an SDI or analog capture card such as a 
Decklink or Kona, you can choose any other codec for encoding your 
videos. If you choose a codec such as Photo-JPEG or IMX, you can capture 
at about the same data rate (25 Mbit/sec) and quality as DV 25, but tape 
name and timecode information are saved correctly. Photo-JPEG and 
IMX are both excellent offline-quality choices. In addition, IMX also 
meets some users' needs as an online-quality codec, especially IMX 50. 
Both of these codecs play back well even on machines that lack capture 
cards.

• If you are capturing via FireWire, you can transcode your video from 
DV 25 to Photo-JPEG or IMX during capture. You simply need to create 
a new Easy Settings or Capture template. However, this might require 
more CPU power than some older workstations are capable of, resulting 
in occasional dropped frames.

• If you prefer to continue using DV 25 or DV 50, EditShare recommends 
you use Final Cut Pro's option to limit the size of media files to prevent 
media files from growing larger than 2 GB. This does not limit the length 
of a captured clip: Final Cut Pro stores the clip in multiple files, each of 
which is under 2GB in size, but it still only creates a single clip. You only 
see the difference if you look at the Capture Scratch folder using the Finder 
or other applications outside of Final Cut Pro.

You can limit the media file size. In System Settings in the Scratch Disks 
tab are several options including one to Limit Capture/Export File 
Segment Size to ____ MB. Make sure that option is selected, and type 2000 
in the text box (2000 MB is 2 GB).
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Managing Render Files

After rendering effects with Final Cut Pro, if you later make changes to your 
sequence, Final Cut normally deletes your older rendered files. However, in the 
following cases, Final Cut cannot delete the obsolete rendered files:

• If you are rendering to a Managed Media Space and your rendered files 
have been Protected, Final Cut Pro cannot delete the obsolete render files.

• If you are rendering to a Traditional Final Cut Media Space and your 
rendered files have been Shared, Final Cut deletes the shortcuts to the 
rendered files, but it cannot delete the Shared files themselves.

The best solution is to use a separate Media Space – ideally an Unmanaged 
Media Space – for rendered files than you use for capturing, and never 
Protect or Share that Media Space. This way you always have the ability to 
delete your own files from this rendering Media Space. Alternatively, you 
can render files to a folder on your local drive.

Rendering to the Wrong Drive

Many users have reported that Final Cut Pro occasionally starts rendering to 
local drives, even though the Scratch Disk settings say that files should be 
rendered to a Media Space on the EditShare. This problem can be solved by 
closing Final Cut Pro and deleting the Final Cut Pro preferences file.

Strategies for more Reliable Output

Final Cut Pro does not necessarily require you to fully render a sequence before 
an Edit to Tape or Print to Video operation. On more powerful computers, for 
lower-resolution video, it can often render many effects on the fly. However, 
when you are using network storage, more CPU power is used to transfer the 
data than Final Cut might expect. This can result in dropped frames during 
output. 

On less powerful computers, or when working with higher-resolution video or 
more complex effects, Final Cut Pro automatically renders the unrendered clips 
before outputting. This can be convenient, but it has the following drawbacks:

• The clips are rerendered every time you Print to Video, which can take a 
long time for sequences requiring a lot of rendering.

• The temporary render files created during this process are neither used 
nor deleted after the Print to Video operation completes, so they can end 
up taking up a lot of disk space.
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To avoid dropped frames and unexpected use of disk space, EditShare 
recommends that you always render your sequence before Printing to Video or 
Editing to Tape, especially when you are working with higher bandwidth video 
such as DVCPRO HD or uncompressed video.

Avoiding Dropped Frames with Longer DV 25 Clips

Since its first version, Final Cut Pro has been susceptible to dropped-frame 
issues when you are capturing. Great effort has been put into tuning the DAVE 
SMB client to avoid dropped frames, and if you work with the EditShare 
provided version of DAVE instead of native SMB or AFP, you are unlikely to 
encounter any dropped-frame issues when capturing at any resolution from 
OfflineRT to DV 25 all the way to Uncompressed SD 10-bit. 

If you choose to work with Native SMB or AFP, however, when you are 
capturing DV 25 media over FireWire it is not unusual to encounter dropped 
frames after about 16 or 17 minutes of capturing. If there is no dropped frame 
at that point, chances are high that there is one at about 34 minutes. This is a 
known issue in Final Cut Pro when you are capturing DV 25 to any network 
drive.

If you are not using DAVE, EditShare strongly recommends capturing media in 
Final Cut Pro in clips under 15 minutes in length. Many editors find that Final 
Cut Pro generally works best with clips under 10 minutes in length.
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EditShare supports the use of FCP X for the storage of media as well as the 
storage of Events and Projects. With default EditShare configurations, 
individual editors can store their own media in their own Events and Projects 
on an EditShare server.

To use FCP X with EditShare Shared Storage products, consult the following 
sections.

• Network Protocols Compatible with FCP X

• Using Final Cut Pro X 10.1 with EditShare Storage

• Using Final Cut Pro X 10.0 with EditShare Storage

Network Protocols Compatible with FCP X

EditShare supports using both SMB and AFP with FCP X, and recommends 
using Unmanaged Media Spaces to store both media and project files. 

FCP X natively supports access to network volumes over SMB. EditShare 
uniquely provides AFP support for FCP X as well.

NOTE:  If you’re using FCP X 10.0.x, see Using Final Cut Pro X 10.0 with EditShare 
Storage for details. FCP X 10.0 uses SAN Volumes for metadata files on networked 
volumes, while 10.1 uses Library Bundles; these two approaches are incompatible.

Using FCP X with AFP-mounted Media Spaces

To use FCP X on AFP-mounted EditShare Media Spaces, editors must first 
enable FCP X support in EditShare Connect:

TASK

1. Open EditShare Connect and log in.

2. Click the Settings tab.
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3. Click the Final Cut Pro section.

 

4. Click the button next to Enable AFP support.

5. Quit EditShare Connect.

6. Reopen EditShare Connect and log in.

 

You should now see a “Launch FCP X” button next to the server status at the 
top right of the EditShare Connect interface.

7. Click “Launch FCP X” to start FCP X with AFP support enabled. FCP X should 
now be able to access EditShare Media Spaces mounted via AFP.
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Using Final Cut Pro X 10.1 with EditShare Storage

Final Cut Pro X 10.1 introduces a new project format, the Library Bundle, which 
changes how FCP X links to media. FCP X 10.1 now uses hard links in some of 
its normal operations. Hard links are designed for local storage and cannot be 
created on networked storage mounted via SMB and AFP.

Specifically, FCP X 10.1 makes hard links during the conversion process 
between the old and new FCP X project formats, and it makes hard links when 
importing media from the same volume as the project’s library.

In FCP X 10.1.x, you now have a Library Bundle, which appears in Finder as a 
file with the .bundle extension. FCP X 10.1 Events and Projects now reside 
inside the bundle file. The bundle can’t be opened in Finder like a normal folder, 
and only one person can open a bundle at a time.

Managing Projects and Media in FCP X 10.1

In FCP X 10.1, if you copy a media file from one place to another within the 
same volume–for instance, from one project’s Events to another project’s 
Events on the same media space–FCP X will attempt to create a hard link. As 
with the project conversion process, this will fail on shared storage.

However, if you copy media from one volume to another, FCP X 10.1 either 
creates a symbolic link that's allowed on shared storage, or copies the file.

If you use the Import dialogue in FCP X to import a file or clip, it will follow the 
default rules you set up to make a copy or a link. However, dragging media from 
Finder into FCP X will not follow those rules.

EditShare recommends changing your workflow for storing media files if you’re 
running FCP X 10.1. You should keep your shared media on a separate media 
space from your projects.

For example, if you kept FCP X projects and your QuickTime media on the 
same Unmanaged media space, EditShare recommends creating a new 
Unmanaged space and moving your projects or media to that new space. 
Editors will need to mount both spaces–the space containing the project and the 
space containing the media–to work on the project.

Issues Converting FCP X 10.0.x Projects to 10.1

FCP X 10.1 creates hard links to all the media files when converting a project 
from 10.0.x to 10.1 in order to avoid duplicating media. Since hard links can’t 
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be generated on shared storage devices, such as EditShare media spaces, the 
conversion process fails.

One temporary workaround is to export the media space that contains the 
project as an NFS volume, which emulates local storage and supports the hard 
links required by FCP X 10.1. After mounting the space via NFS, FCP X is able 
to update the projects; once finished, you can revert to mounting the space via 
SMB (or for some beta users, AFP) to access your FCP X projects.

To convert the space:

TASK

1. Switch the space’s protocol to remove resource forks, which will cause 
problems when mounting via NFS. For instance, if the space is set to be 
mounted via SMB, switch the space’s protocol to AFP via the Modify Media 
Space section of the appropriate EditShare Manager.

2. Export the space to NFS, then mount it on the workstation. For more 
information, see the EditShare Administrator’s Guide.

3. Convert the project using FCP X 10.1.

4. Convert the media space back to an SMB-accessible media space.

RESULT: 

NOTE:  After FCP X 10.1 converts the project, you may see an error suggesting the project’s 
media files need to be relinked. In limited testing in cooperation with Apple, this error 
appeared to be false—media files in the project were online. If you encounter any issues, 
please contact EditShare Support.

Another workaround is to move the FCP X 10.0 project to local storage before 
converting it to a 10.1 project. The converted bundle can then be moved back to 
the media space. However, if your project has a large amount of media inside 
the project directories, all of that media must be moved as well. This may not be 
possible on exceptionally large projects or if there’s limited local storage, and 
may take a long time to copy over the network.

Once the conversion is complete, FCP X 10.1 may ask whether you want to keep 
the 10.0 project directory. EditShare recommends answering no to this prompt, 
which makes the newly created bundle a standalone project that can be copied 
back to shared storage.

NOTE:  This process can’t be automated by the server as FCP X itself must convert the 
project files. Each project on each media space must be converted individually.
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Using Final Cut Pro X 10.0 with EditShare Storage

When creating a SAN Volume in FCP X 10.0, you can select any EditShare 
Unmanaged Media Space that has been mounted by DAVE SMB, or you can 
select a folder in the space. Multiple users can have SAN Volumes on the same 
physical EditShare Media Space by creating folders for each user and adding just 
specific folders as SAN Volumes. Once you have designated an EditShare Media 
Space or a folder in the Space to be a SAN Volume, you can create FCP X Events 
there and capture or transfer media into the Event. 

NOTE:  FCP-X users can store media files in EditShare Managed or Unmanaged Media 
Spaces mounted by either DAVE SMB or AFP, but FCP-X Events can only be created on 
Unmanaged Media Spaces mounted by DAVE SMB. The rules of Managed Media Spaces 
are not compatible with some features of FCP-X. 

Saving FCP X Projects on EditShare Storage

In FCP X, Projects are the equivalent of Final Cut Pro 7 sequences. FCP X 10.0 
Projects can be saved on EditShare Storage, in the same SAN Volumes where 
Events and media are stored. FCP X saves all render files associated with a 
Project in the Project directory on the SAN Volume. 

Moving an FCP X Edit Session from One Workstation to Another

FCP X does not allow multiple FCP X workstations to use the same SAN volume 
simultaneously. You can configure the same SAN volume for use on two 
different FCP X workstations, but only one workstation at a time can use that 
volume. If you have a SAN Volume mounted and FCP X is running, the volume 
is considered to be in use. To move an edit session from one workstation to 
another, you either need to close the FCP X application on the first workstation 
so that you can open it on the second workstation, or you need to remove the 
SAN Volume from the first workstation so that the second one can use it.

Sharing Media

In order to share media, FCP X users must import clips from other EditShare 
Media Spaces (these can be SAN Volumes or not) into their own Events. If you 
create an FCP X event in an Unmanaged Media Space with the default EditShare 
configuration, FCP X makes a new copy of any imported media in your own 
Event. You can reconfigure your EditShare server so that FCP X makes links to 
the media instead of copying it. In a forthcoming version of EditShare, there will 
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be an option to automatically reconfigure your EditShare system to support 
FCP X media linking. Until then, if you want to manually reconfigure your 
EditShare system to support media linking, you must contact EditShare 
Technical Support to make a simple server configuration change. 

If you choose to support FCP X media linking, you cannot use Avid Shared 
Project Spaces, FCP Shared Project Spaces, or Avid MXF Media Spaces, because 
the change that makes FCP X media linking possible conflicts with those types 
of spaces. However, you can still use Lockable Shared Project Spaces as well as 
Avid Style, Managed, and Unmanaged Media Spaces. Even with full FCP X 
media linking support, you can still get project and media sharing for all other 
popular NLEs. 

Sharing FCP X Projects Between Multiple Editors

It is not currently possible for one FCP X editor to open a Project as Read Only 
while another editor is working on it. While EditShare developed and patented 
the concept of FCP Project Sharing and Shared Project Spaces – which makes it 
possible for a whole group of FCP7 editors to open the same projects 
simultaneously with a guarantee that only one editor at a time is granted write 
access to the project – FCP X does not allow more than one user at a time to 
access a Project or Event, even if additional users do not have write access to the 
Project or Event. 

FCP X writes hidden In Use files inside every SAN Volume, and when a second 
FCP X application tries to mount that SAN Volume to open up a Project or 
Event that is being used by another editor, an error box opens saying the SAN 
Volume is already in use by another FCP X application. 

NOTE:  You cannot store FCP X Projects inside EditShare Shared Project Spaces. Shared 
Project Spaces were designed for metadata only, and EditShare blocks the storage of 
media files there; because FCP X stores all render files in the same location as the Project, 
FCP X Projects therefore must be stored on Managed or Unmanaged Media Spaces.

Sharing FCP X Projects Via XML Export and Import

It is possible to export an XML copy of your FCP X Project and for another user 
to import the XML into his or her own FCP X SAN Volume. This is one way 
that multiple users can work on the same Project at the same time. Once 
imported, the second user has a read/write copy of the Project that should link 
to all the media, assuming the media has also been imported into an Event on 
the same SAN Volume. 

NOTE:  Depending on the FCP X version, EditShare has sometimes seen that FCP X can 
hang when importing a Project XML into a EditShare Space that has been configured as 
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a SAN Volume. A simple workaround is to first import the XML onto a local drive and 
then simply copy it by drag and drop to the EditShare Media Space that has been 
configured as a SAN volume. 



Chapter 10: Using EditShare with Adobe 
Premiere Pro

EditShare central storage is an excellent solution when you want to store your 
Adobe Premiere Pro projects and media in a central location for use by 
individual editors, or when you want to safely share the media and projects 
between multiple editors. In order to have a successful experience using Adobe 
Premiere Pro with EditShare, read the following section carefully. It explains 
the importance of choosing the right types of Spaces for best compatibility with 
Adobe Premiere Pro and how you should configure Adobe Premiere Pro for 
best operation with shared storage.

See the following topics:

• Adobe Premiere Pro Workstation Setup

• Media Space Design and Usage

• Considerations for Media Sharing

• Lockable Project Spaces

• Adobe Premiere Pro Setup

Adobe Premiere Pro Workstation Setup

To get the full benefit of EditShare's integration with Adobe Premiere Pro, on 
each workstation, your system administrator has installed EditShare Connect. 
You are required to enter your EditShare usernames and passwords to log into 
this EditShare client application. 

Editshare Connect allows you to do the following:

• Mount those Spaces on your local workstation.

• Create and manage Shared Projects in the Project Browser section of 
EditShare Connect.

• See a listing of the Media Spaces and Project Spaces on EditShare central 
storage you are authorized to access.

• Change your EditShare password (if enabled by the EditShare 
administrator).
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To prepare a client workstation for use with Adobe Premiere Pro and EditShare, 
do the following.

TASK

1. Install Adobe Premiere Pro, and then apply the latest updates.

2. If necessary, install the latest version of NVIDIA CUDA for your graphics card.

3. Install the EditShare Connect software (administrator level access required).

Media Space Design and Usage

Media Spaces are network shares located on the EditShare Storage server that 
contain your media files. There are a number of types of media spaces, each of 
which have different structures and permissions. Adobe Premiere Pro can read 
from and write to both Managed and Unmanaged Media Spaces. It is important 
to understand how the rules of these two EditShare Media Space types differ.

In a Managed Space, media files are owned by the user who created them, and 
are read-only to all other users. Adobe Premiere Pro plays back media files from 
a Managed Space perfectly well, even if it only has read-only access to some or 
all of them. Another key rule of Managed Spaces pertains to folders. While all 
users can write files into any folder in a Managed Space, the moment a folder is 
no longer empty, the folder becomes owned by the EditShare Administrator. It 
is not possible for ordinary users to rename, move or delete a folder that has 
content that may belong to that user or others. If you need to rename or delete 
folders that are not empty, or delete files that do not belong to you, a Managed 
Space can be put into Maintenance Mode by the EditShare Administrator, 
which gives temporary administrator privileges to that space to one selected 
user.

In an Unmanaged Space, there are fewer restrictions: all files are readable and 
writable by everyone, allowing anyone to delete or modify any file. 

In addition to these basic rules, you can restrict selected users of Managed and 
Unmanaged Spaces to read-only access. All files and folders in that Space are 
read-only to that user, meaning the user cannot create, modify, move, or delete 
any of the files or folders.

Both of these Media Space types are valid for use with Adobe Premiere Pro, and 
each has its own advantages and disadvantages, depending on the user 
workflow. Managed Spaces guard more against the risk of accidental deletion, 
while Unmanaged Spaces provide more flexibility for everyone to delete and 
organize media files as needed. With Adobe Premiere Pro, EditShare generally 
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recommends using Managed Spaces for source media files, and Unmanaged 
Spaces for render files. This provides the best protection for source media files 
with the flexibility to clean up render files, which can be recreated with relative 
ease, if necessary.

Sometimes you might want to use Adobe Premiere Pro with EditShare Avid 
Style Media Spaces. Avid Style Spaces have similar rules to Unmanaged Spaces, 
except they emulate native Avid storage when connected to Avid NLE 
applications. As a rule, you should probably avoid configuring Adobe Premiere 
Pro to write to Avid Style Media Spaces.

However, if your workflow includes both Avid and Adobe Premiere Pro editors, 
you can export an AAF from any Avid sequence that has its media on an Avid 
Style space and then import it into Adobe Premiere Pro. The sequence and 
media should link up. 

NOTE:  This only works with MXF files in specific codecs such as DV25, DVC Pro, DV50, 
DVC Pro HD, XDCAM-HD, and AVC-intra. For example, DnxHD is not currently 
supported with this workflow. 

You should always avoid using Avid MXF Media Spaces with Adobe Premiere 
Pro, as these are designed specifically for editing Avid media with Avid NLE 
applications. 

The Editshare storage should be divided into a number of Managed or 
Unmanaged Media Spaces using the EditShare Manager tools provided in the 
EditShare Workflow Director. Usually you divide media into separate Media 
Spaces for each project, making it easier to assign user permissions and manage 
your media when projects are complete. 

Considerations for Media Sharing

You can share media and projects between multiple Adobe Premiere Pro 
workstations running Mac OS X or between multiple workstations running 
Windows. In general, avoid sharing between Windows and Mac workstations. 
There are currently several limitations with shared projects when you run 
multiple Windows clients, or a mix of Mac and Windows clients, as follows:

• If you work with the same projects on multiple Windows clients, each 
client must assign the same drive letter for a given Media Space. Adobe 
Premiere Pro and Windows are sensitive to the exact path name defining 
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the media file location. If the drives are mounted on different drive letters, 
the paths are inconsistent and users have to relink your media.

To assist you in keeping drive letters consistent, EditShare Connect for 
Windows remembers the drive letters you assign to Media Spaces. If you 
assign drive letters correctly the first time, each subsequent time you sign 
into EditShare Connect, your Media Spaces remount correctly.

In a future release, EditShare will include a Projects Profile feature, 
allowing you to mount the same Media Spaces using consistent drive 
letters.

• If you open the same Adobe Premiere Pro project on both Mac OS X and 
Windows clients, you need to relink the media files each time you open 
them, as the paths to the media are different. On Windows, the path to a 
file might be something like Z:\Clips\Day1\firstshot.mov whereas on Mac 
the path would be /Volumes/SpaceName_1/Clips/Day1/firstshot.mov. 
Adobe Premiere Pro on Windows and Mac would not see these paths as 
the same.

• Render Files are not cross-platform compatible. If you open the same 
Adobe Premiere Pro project on Mac OS X and Windows workstations, 
Adobe Premiere Pro discards the files and you have to rerender them. This 
is a current Adobe Premiere Pro restriction.

Lockable Project Spaces

EditShare Lockable Project Spaces allow you to safely store and share multiple 
Adobe Premiere Pro project files in a central location that can be accessed and 
written to by other users at the same time. In this workflow, Adobe Premiere 
Pro project files are not stored in the same place as media files and render files, 
but are stored separately in an EditShare Lockable Project Space where 
EditShare rules ensure each project file can only be opened for writing by one 
user at a time. 

When you make a new project in a Lockable Project Space, you create a top level 
Project Folder where you and your colleagues store the various files that make 
up the entire Project. Large projects are broken down into smaller ones so each 
editor has control over the portion of the project they are working on. For 
example, one editor can work on Scene 1 while another editor works on Scene 2. 
Both scenes are part of the same movie, but each scene is represented by a 
separate Adobe Premiere Pro project file.
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When you want to work on a particular project file, you unlock it. This gives you 
exclusive write access to that file, and locks it (makes it read-only) for other 
users. Even though a project file might be locked for other users, they can still 
have read-only access to your project file, allowing them to play and review its 
contents. Users can also import elements from locked project files into project 
files they control. The only thing they cannot do is modify a project file while 
somebody else has it open for writing.

You can also use the Adobe Premiere Pro project browser to collaborate with 
other users, and lock project files from other Creative Suite applications such as 
Adobe After Effects.

Creating a Lockable Project Space

To create a lockable project space, do the following.

TASK

1. Ask the EditShare Administrator to make a Lockable Project Space. Go into the 
Managed or Unmanaged EditShare Manager tools and click the Project 
Spaces tab.

 

2. Type a name for your new project. 

3. Select Lockable from the Project Type list.

4. Click Add Project Space to System.
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5. To add users to your new space, click Add Multiple. 

 The Add Users window opens. 

6. Add or remove the users you want to have access to your group by selecting 
or deselecting the relevant user. 

7. Click OK to update the user list.

Creating a Project Space

To create a Project Space, do the following.

TASK

1. Open EditShare Connect and log in.

2. Click the Projects tab. 

 

3. Click the New button, then select New Project to create a new project 
container within the Lockable Project. You must make a new project container 
in a lockable space before you can save Adobe Premiere Pro Project files in it.

 Check that you can save Adobe Premiere Pro projects in your project space. 
Launch Adobe Premiere Pro, create a new project, and save it in a location 
within the Editshare Shared Project space.

You can optionally make subfolders within the project container to organize 
your project files, for example, rough cuts, graphics, and so on.

The New Project dialog box opens.
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4. Type a name for your project in the text box and then click OK. 

 The Project Name displays in the Project Browser.

5. Click OK to create the project.

Viewing Projects in EditShare Connect

You can view your Adobe Premiere Pro projects in the EditShare Connect 
Project Browser. Open the project folder to see the projects and the padlock 
icons. 

Each Adobe Premiere Pro project has one of three colored padlock icons next 
to it, indicating the project’s status, as follows:

• Yellow: Neutral state, no users have the project open in read-write mode.

• Green: You have the project locked for read-write access.

• Red: Locked for write by another user, with an indication of the name of 
the user that has it locked.

When you double-click a locked project, you can open it with read-only 
privileges. You cannot save the project, but can view content, play sequences, 
and so on.
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After you finish editing a project, you can save it, and then click the green lock 
icon once to return it to a neutral state, indicated by a yellow padlock icon. 
Another user can now open the project with read-write privileges by double 
clicking on it.

Adobe Premiere Pro Setup

See the following topics:

• “Setting Media Space Locations” on page 159

• “Storing Projects and Media Separately (Recommended)” on page 161

• “Storing Project and Media Files Together” on page 161

• “Audio Settings” on page 162

Setting Media Space Locations

For every new Adobe Premiere Pro project you make, you must set the Media 
Space location(s) of all media and render files, and set a number of other 
options. Do the following.

TASK

1. Open Adobe Premiere Pro. In the Welcome screen that opens, click New 
Project. 

 The New Project Dialog box opens. 

2. In the General tab, make any changes to settings for your project as required.
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3. Click the Scratch Disks tab

 

4a

4b

4c

4d

3

4. Set the locations for:

a Captured Video

b Captured Audio

c Video Previews

d Audio Previews

 All media types default to Same as Project. Depending on your workflow 
requirement, you should follow one of the procedures described in “Storing 
Projects and Media Separately (Recommended)” on page 161and “Storing 
Project and Media Files Together” on page 161.

NOTE:  If you need to adjust the media file scratch disk locations for an existing 
project, select Edit > Preferences > Media. 
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Storing Projects and Media Separately (Recommended)

For the best and safest collaborative workflow, EditShare recommends that you 
store your Adobe Premiere Pro projects in a Lockable Project Space. You must 
adjust the Scratch Disk media locations to point to the appropriate Media 
Spaces for each new Adobe Premiere Pro Project that you make.

NOTE:  Shared Project Spaces cannot be used for media file storage. If you store Adobe 
Premiere Pro projects in a lockable Project Space, you cannot leave the default setting 
Same as Project for Scratch Disk media file locations. You encounter problems if you try 
to capture or render media files to a Project Space location.

For the best combination of flexibility and protection in this case, EditShare 
recommends the following Scratch Disk setup.

• Captured Video and Audio: Managed Media Space, generally one per 
project

• Previews and Audio Previews: Unmanaged Media Space, generally one 
per project

• Project Auto Save: On each workstation's local drive, or an Unmanaged 
Space

Make sure you are logged into EditShare Connect. For each Scratch Disk type, 
navigate to the appropriate Media Space path.

When you have completed the Scratch Disk selections, save your Adobe 
Premiere Pro Project to the appropriate Shared Project space path. Once saved, 
your project shows up in the EditShare Project Browser. The user who created 
it sees a green lock next to his or her project, while other users see a red lock with 
the owner’s user name alongside.

Storing Project and Media Files Together

If you do not wish to collaborate on Adobe Premiere Pro projects with other 
editors, and you are not using Lockable Project Spaces, you can store your 
Adobe Premiere Pro project file in a Managed or Unmanaged Media Space, and 
you can leave the media locations at the default setting Same as Project. The 
default settings for scratch disks within Adobe Premiere Pro expect that all 
media files, graphics, audio and renders be kept in the same folder or Media 
Space as the project. This has the advantage that separate render Media Spaces 
do not have to be set up, as is common with Avid based installations.
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Audio Settings

Audio

You might want to switch off audio peak generation for projects that contain a 
lot of audio, otherwise they take a long time to open. Select Edit > Preferences > 
Audio > Turn off Automatic Peak File Generation.



Appendix A: Traditional Media Spaces

Traditional Media Spaces were the only types of Media Spaces available on the 
original EditShare systems.  Traditional Media Spaces are now obsolete and it is 
no longer possible to create new Traditional Media Spaces.  If your system has 
been upgraded over the years and it still has some Traditional Media Spaces, 
you should read this chapter for information about how they work.  Otherwise, 
you can skip this chapter.

In a Traditional Media Space, you have your own view of each Media Space. 
When you add files to a Traditional Media Space (by capturing or rendering, for 
instance), the files are not initially visible to other users. In order to make the 
new files visible to others, you must explicitly Share them, and then each other 
user must Refresh his or her view of the Media Space to see the new files that 
have been added.

NOTE:  The EditShare guides use the capitalized terms Share and Refresh specifically to 
refer to the actions of making files you have stored in a Media Space available to others, 
and of viewing files recently Shared. When the more common everyday uses of the words 
share and refresh are intended, the terms are not capitalized.

Traditional Media Spaces offer an Unshare function to greatly simplify the 
process of organizing or deleting Shared media. 

The following table describes the features of Traditional Media Spaces.

Feature Description

Supported NLE Limited support for all NLEs)

Network Protocol Avid, Adobe Premiere Pro: SMB only 
Final Cut Pro, Other NLEs: SMB or AFP

Access Control Users must be added to the Media Space to have access 
Public option

User Operations Share 
Refresh

Administrator Operations Unshare/Reshare 
Resolve conflicts

Contents (Avid) OMFI MediaFiles 
Avid MediaFiles 
Miscellaneous
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The Share and Refresh system is how Traditional Media Spaces protect shared 
media files from being mistakenly or maliciously erased. When you Share a 
media file, it is moved to a protected area that cannot be directly accessed or 
modified by any user. In your private view of the Media Space, the file is 
replaced with a shortcut or alias that points to the place where the file was just 
moved. You continue to see the file, but you cannot modify it. When other users 
Refresh, they get their own shortcut to the same common file.

For Avid users particularly, this Share and Refresh system prevents Avid 
applications from being surprised by the sudden appearance and disappearance 
of new media files, which can cause Avid NLEs to scan the new files to update 
their media databases.

Sharing and Refreshing must be performed each time new clips or rendered files 
are added to a Traditional Media Space in order to make the new files available 
to other users and protect them from accidental deletion. If you desire it, 
Sharing and Refreshing can be done automatically at an interval set by the 
EditShare Administrator. Automatic Sharing and Refreshing is not always 
appropriate, however. See "Manually Sharing and Refreshing Media Spaces" on 
page 169 for instructions for manually Sharing files, and for configuring 
Automatic Sharing. 

Once files in a Traditional Media Space have been Shared, some restrictions are 
placed on what you can do with them in order to prevent deleting or modifying 
them in a way that could be harmful to other users. Before you share files, you 
can directly modify them or even delete them. For instance, you might want to 
do the following:

• Change the name of a file

Contents (Final Cut Pro) Capture Scratch 
Render Files 
Audio Capture Scratch 
Audio Render Files 
Waveform Cache 
Thumbnail Cache Files 
Miscellaneous

Contents (Adobe Premiere Pro) Adobe Premiere Pro Preview Files 
Capture 
Conformed Audio Files 
Miscellaneous

Contents (Other NLEs) Shared Media 
Miscellaneous

Feature Description
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• Modify the tape or reel name as recorded in the metadata embedded in the 
media file

• Recapture a file to change its color correction or aspect ratio

You should make these changes before you Share the file. If you need to modify 
a file stored in a Media Space after it has been Shared, see "Modifying Files in 
Traditional Media Spaces" on page 167.

NOTE:  In many cases, your non-linear editing system or graphics application allows you 
to move or to modify files that have already been Shared. However, since you only modify 
your own shortcut to the file, and not the file itself, these changes are not seen by other 
users. Such changes do not persist even in your own view of the Media Space, and in some 
cases can cause you or others to be unable to properly Share or Refresh those files.

Also see the following topics:

• "Miscellaneous Folder" on page 166

• "Modifying Files in Traditional Media Spaces" on page 167

• "Sharing and Refreshing Media Spaces" on page 168

• "Manually Sharing and Refreshing Media Spaces" on page 169

• "About Automatic Share and Refresh" on page 170

• "Automatically Sharing and Refreshing" on page 172

• "Administrator Share and Refresh" on page 172

• "Deleting and Organizing Media by Unsharing" on page 173

• "Managing File Names" on page 174

• "Using Traditional Adobe Premiere Pro Media Spaces" on page 174

• "Media Databases and Traditional Avid Media Spaces" on page 176

Editors – Traditional Spaces Workflow

EditShare provides limited support for Traditional Avid, FCP, and Other NLE 
Media Spaces (these were Spaces in which you had to Share and Refresh in order 
for editors to see each others’ media files). If your v7 EditShare system includes 
any such Traditional Spaces (for instance, you might have upgraded from 
EditShare 4 or earlier), you can continue to manage your Traditional Spaces 
with EditShare Manager: you can add and remove users from the Spaces, set 
quotas, Share and Refresh, and so on. However, you can no longer create any 
new Traditional Media Spaces. If you are working with EditShare for the first 
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time, or beginning a new project on a system that already has some Traditional 
Spaces, you only have the option of using newer types of Media Spaces – Avid 
Style, Avid MXF, Managed, Unmanaged, and Universal.

Miscellaneous Folder

NLE Specific Folder

Avid Media files must be in OMFI MediaFiles or in Avid MediaFiles folders 
(which Avid automatically does)

Final Cut Pro Files must be in one of the standard Final Cut Pro folders: Capture 
Scratch, Audio Capture Scratch, and so on

Adobe 
Premiere Pro

Files must be in one of the standard media folders: Capture, Conformed 
Audio, Video Render, and Audio Render

Other NLEs Files must be in the Shared Media folder

Within each Traditional Media Space, EditShare creates a Miscellaneous folder 
in addition to the folders needed for the editing application. In older versions of 
EditShare, this folder was sometimes used to store files such as animations, 
photographs, mattes, and music files that would later be imported into or 
referenced by an editing application. However, it is now simpler to use a 
Managed or Unmanaged Media Space for such files. As such, EditShare 
recommends not using the Miscellaneous folder on new systems.

Any files stored in the Miscellaneous folder of a Traditional Media Space are 
treated just like other media files stored in the other folders in the Media Space. 
They can be Shared and Refreshed. They must not be modified or deleted after 
being Shared. When the Media Space is deleted, all of the files in its 
Miscellaneous folder are deleted.

EditShare Shares only files that are located within the specific folders for your 
editing application, plus the Miscellaneous folder. See the following table.

Put anything else you want to share in the Miscellaneous folder. If you put files 
anyplace else in the Media Space, they are not Shared and cannot be seen by 
other editors.
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Capture Locations

Folder Contents

Shared Media folder Captured video, rendered files, waveform files, thumbnail files, 
and so on

Miscellaneous folder Graphics files, photos, mattes, and so on

With a Traditional OtherNLE Media Space, EditShare Manager creates two 
folders inside that Space. It’s important to put appropriate files into the 
appropriate folders. 

You must put all your media files into the Shared Media folder. This includes 
captured video, rendered files, waveform files, thumbnail files, and so on. You 
should put graphics files, photos, mattes, and so on in the Miscellaneous folder.

Only files inside these two directories are shared. Any files outside these folders 
are only accessible to a single user (the one who created the file or put it there).

Modifying Files in Traditional Media Spaces

While it is often possible to modify files in a Traditional Media Space, especially 
in the Miscellaneous folder, doing so might not have the results you expect.

For example, suppose you have created a graphic called “Opening Title,” put it 
into the Miscellaneous folder as a TIFF or JPG or Photoshop file, and Shared it 
so others can see it. Then later, your executive producer decides you need to 
change the color of text in the title graphic. It would be tempting to simply open 
up the file, change the color, and save the title again with the changes. This will 
not have the results you want.

 If the file has already been Shared, then there is a very good chance (depending 
on the architecture of the program used to edit the file) that a new file will end 
up getting saved in your own “private view” of the Miscellaneous folder within 
that Media Space. This makes that file available to you, but the original version 
of the file remains in the Miscellaneous folder within the “public view” of the 
Media Space, available to everyone else. If you then try to Share your new file so 
that others can see the changes you made, EditShare does not automatically 
replace the old file in the public view with the modified file from your private 
view. The whole idea of EditShare's Share and Refresh system, after all, is to 
protect shared files from just this sort of unilateral modification.



APPENDIX A: TRADITIONAL MEDIA SPACES
SHARING AND REFRESHING MEDIA SPACES

 168

If you really do need to modify a file that has already been Shared, you can do 
one of the following:

• Use your NLE or other application to modify the original file and save it, 
creating a name conflict. The original version remains in the public view 
of the Media Space, and your modified version exists only in your private 
view. To get the modified file to replace the original file in the public 
Space, have your EditShare Administrator resolve the conflict, following 
the instructions in the EditShare Administrator's Guide. This describes the 
procedure that allows the Administrator to replace the original file with 
the modified one.

• Make a copy of the Shared file in a different location, such as a local hard 
drive or a part of the Media Space outside of the Shared folders. Then 
delete the original file, following the procedure described in "Deleting and 
Organizing Media by Unsharing" on page 173. Then you can modify the 
copy of the original file, copy the modified file back to its original location 
in the Media Space, and Share it. After other users subsequently Refresh 
the Media Space, they and their applications see the modified file instead 
of the original one.

• When you modify the file, select File > Save As (instead of Save) to save 
your changed file with a new name. This creates a new file, which you can 
then Share like any other new file. When other editors Refresh the Media 
Space, they see both version of the file and can tell their NLE or other 
applications to use the new version instead of the old version.

NOTE:  Consider using a Managed or Unmanaged Media Space for storing any file that 
is likely to need modifying.

Sharing and Refreshing Media Spaces

The key to safely and correctly sharing media files in Traditional Media Spaces 
is using the Share and Refresh functions. When you create new files in a Media 
Space – perhaps by capturing media from a tape – the files are not made 
available to other users until you Share the Media Space. In order to see the new 
files, other editors must Refresh their own views of the Media Space. 

Sharing and Refreshing can be done automatically, manually by editors, or a 
combination of both. Manual Sharing and Refreshing gives editors total control 
over exactly when these functions occur. Automatic Sharing and Refreshing is 
available as an option to simplify these procedures in some cases for editors who 
do not want to manage them manually. Administrators have the ability to 
enable, require, or disable this feature for each user and or Media Space on the 
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system. You can work either way, or switch back and forth as you perform 
different sorts of tasks. This section provides instructions for both workflows.

Before you Share media, you are able to delete it from within your editing 
application as if it were stored locally on your own workstation. For example, if 
you start digitizing some clips and decide you want to delete them, you actually 
delete them from the EditShare server if you delete them from your bin. 

However, after you have Shared the media, your Media Files effectively become 
read-only to you. You can access them, but you can't delete them; it is now 
assumed that the media might be important to other users. Your editing 
application “thinks” that it can delete shared Media Files, but if you delete 
Shared media either through your editing application or through a file manager 
on your desktop, you are taking away your own access to that media. The files 
go offline, but they won't really be deleted from the EditShare Server. And if you 
simply Refresh your Media Space again, you get all the deleted Media Files back 
again.

To truly delete Media Files, you must follow a specific procedure as discussed in 
"Deleting and Organizing Media by Unsharing" on page 173. 

Manually Sharing and Refreshing Media Spaces

You can share or refresh an individual Media Space or multiple Media Spaces at 
the same time. You do not need to Share and Refresh the same set of 
Media Spaces. 
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To manually share or refresh a Media Space, do the following.

TASK

1. (Avid only) Turn off your Avid editing application before you Refresh to avoid 
freezing or interrupting critical editing tasks (particularly digital cut and 
render). 

2. Select the Media Spaces you want to Share or Refresh by selecting that option 
in the right two columns of EditShare Connect.

 

3. Do one of the following:
• For a single Media Space, click the Now button in the Share or Refresh 

column of the Media Space.

• For multiple Media Spaces, click the Share Checked Media Spaces or 
Refresh Checked Media Spaces button in the Share Management area at 
the bottom left of the window.

• To Share or Refresh all Spaces, select Manual Share or Manual Refresh.

 A message opens in the status box indicating how many files were Shared, 
Refreshed, or found in conflict. 

4. Check the status bar to make sure the operation completed successfully.

5. If files were found in conflict, see your EditShare Administrator.

About Automatic Share and Refresh

If your EditShare Administrator allows it, you can set your Media Spaces to 
automatically Share or Refresh periodically. The EditShare Administrator can 
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also configure your Media Spaces to Share or Refresh automatically, but not give 
you control.

The EditShare Administrator sets the length of time that elapses between each 
Auto Share or Auto Refresh event. These times can be different for different 
Media Spaces.

Automatic Sharing works exactly like manual sharing, with the following 
exceptions:

• Files in the Miscellaneous folder are not automatically Shared. This helps 
protect you from accidentally Sharing files that are not yet ready to be 
Shared. For example, you might create a Photoshop file in the 
Miscellaneous folder, intending to create content in it once and then save 
it (and not modify it again). You would not want the file to be 
automatically Shared before you were finished creating it, because then 
you would not be able to modify it.

• Files are not automatically Shared if they have been modified very recently 
or are smaller than 100 kB in size. This helps prevent Sharing media files 
that are still in the process of being captured.

Automatic Refreshing works exactly like manual Refreshing.

CAUTION:  If you are working with Avid NLEs, EditShare strongly advises you not to 
enable Automatic Refresh for your Media Spaces. Automatic Refresh interrupts your 
work whenever it occurs, and worse, it can result in corruption of project files if your 
system ever Refreshes at the same time you are capturing or rendering files. EditShare 
only makes Automatic Refresh available for Avid Media Spaces in case your facility 
has certain non-Avid machines or users that also need to see Avid media files (such as 
Graphics artists or encoding machines) and for some reason those users or machines 
cannot use Manual Refresh. Most likely, your EditShare Administrator will disable 
Auto Refresh for any Avid Media Spaces, except for users or machines that can use the 
feature safely.

CAUTION:  If you are working with Final Cut Pro, EditShare strongly advises you not 
to enable Automatic Share with DAVE at this time. There is a minor bug in the 
current version of DAVE (at least through version 7.1) that results in any clip that is 
being captured when a Share operation occurs being corrupted so it is not readable by 
Final Cut Pro.

If the Administrator allows it, you can use EditShare Connect to specify, for 
each Media Space to which you have access, whether it automatically Shares, 
Refreshes, Shares and Refreshes, or does none of those. (In some environments, 
the Administrator might not allow you to change this setting.)
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Automatically Sharing and Refreshing

TASK

1. Click the Automatic list for the Media Space you want to control.

 

2. Select one of the following:
• Disabled: The Media Space does not automatically Share or Refresh.

• Share: The Media Space automatically Shares on the schedule estab-
lished by the Administrator, but it does not Refresh.

• Refresh: The Media Space automatically Refreshes on the schedule 
established by the Administrator, but it does not Share.

• Share then Refresh: The Media Space automatically Shares on the 
schedule established by the Administrator, and then Refreshes.

 A message opens in the EditShare status box confirming the change.

NOTE:  You can still Share and Refresh manually whenever you want to.

Administrator Share and Refresh

The EditShare Administrator can Share and Refresh. This should not be 
considered an everyday workflow in most organizations, but might be useful in 
certain circumstances as follows:

• If an editor forgot to Share captured media before leaving for the day, the 
Administrator can Share the media.

• In a school setting, the Administrator might be setting up an editing 
environment for a classroom and want to Refresh a lot of media into a 
Media Space for a large number of students before they arrive.
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• In a rental facility, individual editors renting editing bays might not be 
familiar with EditShare, so the Administrator might Share and Refresh 
for them.

See the EditShare Administrator’s Guide for the procedure for an Administrator 
to Share and Refresh a Media Space.

Deleting and Organizing Media by Unsharing

As mentioned in "Modifying Files in Traditional Media Spaces" on page 167, 
once files stored in a Traditional Media Space have been Shared, you cannot 
directly move, rename, delete, or modify the files. If you try to do so, you only 
affect the shortcuts to the media files, not the files themselves. 

The EditShare Administrator (or a designated user) can Unshare your 
Traditional Media Space. This causes all previously Shared files to become 
owned by you, just as if you captured them and had not yet Shared them. 
Unsharing allows you to freely move, rename, delete, or modify such files. Other 
users do not see the changes immediately (unlike Maintenance Mode for Avid 
MXF and Managed Media Spaces). Before Resharing the media, the 
Administrator has an opportunity to reject changes that you made. Only when 
the change is accepted by the Administrator do other users see those changes.

During the time a Traditional Media Space is Unshared, no users can Share or 
Refresh the Media Space until the maintenance is complete and the EditShare 
Administrator (or other user granted the capability) Reshares the Media Space 
or rejects the changes.

It is generally best, if possible, to have all users disconnect from the Media Space 
before the Administrator Reshares an Unshared Media Space. If any users 
remain connected when the Media Space is Reshared, you might notice the 
following effects:

• Media files might temporarily go offline while the changes made in 
Unshare mode are incorporated into other users’ views. This happens 
even if very few files were actually changed, and lasts longer for Media 
Spaces with more files in them.

• For Traditional Resharing, the Media Space causes the media files to be 
Refreshed in each user's view, but does NOT automatically update the 
Avid media databases. It is recommended, after Resharing a Traditional 
Avid Media Space, that you copy the media database from the user who 
did the maintenance to all other users.
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• If you have a file open that was deleted in Unshare mode (that is, if you are 
playing the media from it) when the Media Space is Reshared, the file 
might not be properly deleted. Consider further the following:

– If the Media Space is mounted using SMB: The file should be deleted 
once it is close (that is, after you stop playing it), but this is not 
completely reliable.

– If the Media Space is mounted using AFP: The file is not deleted and 
no warning is given to the maintenance user. It appears that the file 
was deleted, but it is still present.

All of these problems can be avoided by simply making sure all users are 
disconnected from the Media Space before Resharing it.

When Resharing, the Administrator (or other user granted the capability) can 
send to the EditShare Trash all files that were deleted while the Media Space was 
Unshared. If it is later discovered that some files were deleted that should not 
have been, it is possible to restore them from the Trash. See the EditShare 
Administrator's Guide for information about restoring deleted files.

Managing File Names

Under some uncommon circumstances, Avid might create media files whose 
names begin with a dot (period). Such files are not Shared and Refreshed, so it 
is important to ensure that Avid does not create media files with such names.

One rule of thumb to prevent such files from getting created is to not create 
sequences whose names begin with a dot. If you ever render such a sequence, the 
render file is normally given a name starting with a dot.

Using Traditional Adobe Premiere Pro Media Spaces

If you are a setting up a new EditShare system, EditShare strongly recommends 
that you use Managed Media Spaces for your Adobe Premiere Pro media. While 
Traditional Adobe Premiere Pro Media Spaces continue to work well, Managed 
Media Spaces have significant advantages. See "Managed Media Spaces" on page 
62 for more information about Managed Media Spaces.

By default, if you tell Adobe Premiere Pro to put media on a specific drive, for 
example, the D: drive, Adobe Premiere Pro puts your media in the folders 
shown in the following table.



Folder Description

D: Drive/ Captured audio/video files (.avi) don't usually go into their own folder; they go 
onto the drive you designate

/Conformed Audio Files Conformed audio files (.cfa) that are created for each clip you capture

/Adobe Premiere Pro Render Files Audio and video render files
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EditShare makes one very important change to the default for Traditional 
Media Spaces. It is crucial that you follow the workflow procedure described 
here and in "Setting up Scratch Disks" on page 175 and Naming Clips During 
Capture, or else sharing media files does not work properly.

When you set up a Traditional Adobe Premiere Pro Media Space on EditShare, 
EditShare automatically creates the following folders for that project.

• /Capture

• /Conformed Audio Files

• /Adobe Premiere Pro Render Files

• /Miscellaneous

Setting up Scratch Disks

You must place all captured video files in the /Capture folder. This is different 
from how Adobe Premiere Pro usually works. If you do not put the video files 
in the /Capture folder, the video files cannot be Shared when you tell EditShare 
to Share them.

When you set the Scratch Disk locations in Adobe Premiere Pro, assuming your 
EditShare Media Space is mapped as the Z: drive on your Windows system, your 
capture locations must look like the following. (Note: The Z: drive is just used 
as an example here. Your Media Space could be mapped to any other drive 
letter.)

Drive Contents

Z:/Capture Capture Files

Z:/ Conformed Audio Files

Z:/ Video Render Files
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Do not specify Z:/Conformed Audio Files as the location for the .cfa files. If you 
do, Adobe Premiere Pro creates another Conformed Audio Files folder inside 
the one created by EditShare.

Do not specify Z:/ AudioRender Files or Z:/Video Render Files as the location 
for the render files. If you do, Adobe Premiere Pro creates a new Render Files 
folder inside the ones created by EditShare.

NOTE:  These considerations do not apply if you use a Managed Media Space for your 
Adobe Premiere Pro files. In a Managed Media Space, you can create any folder structure 
that suits your workflow.

Naming Clips During Capture

Adobe Premiere Pro allows you to name your clips anything you choose. That’s 
helpful for creating descriptive names that clearly identify the clips, but it can be 
problematic in an environment where clips are shared; it's entirely possible for 
two users to create clips with the same name. This wouldn't matter if the two 
clips belonged to separate projects. But it would create a conflict if the two clips 
belonged to the same Media Space.

When two or more editors are capturing clips on the same project, it’s a good 
idea to include some unique characters (like the editor's username or initials) in 
all clip names. 

If the you choose not to follow this naming technique, you should at least Share 
and Refresh frequently. Enabling frequent automatic Sharing and Refreshing 
can help with this. As long Editor A is seeing all of the clips that have been 
created by Editors B and C, if a clip name already exists and it has been shared, 
Adobe Premiere Pro won't let Editor A create a clip by the same name.

Media Databases and Traditional Avid Media Spaces

If you are not capturing media using the older Avid OMF format, EditShare 
recommends that you use EditShare’s Avid MXF Media Spaces. In this case, you 
can skip the rest of this section.

For Traditional Avid Media Spaces, media database management is more 
complex. Each editor who is a member of a Traditional Avid Media Space has 

Z:/ Audio Render Files

Drive Contents
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his or her own media database files for each media folder in that Media Space. 
That is, there are multiple copies of the each media database for each media 
folder – one for each user. 

Having independent databases for each user allows editors to freely add new 
clips and render files to a Media Space without affecting the work of other 
editors. When you create or render new clips, your media database is 
automatically updated by Avid to reflect the new clips. 

However, when you Share the new clips with other editors, and those editors 
Refresh their view of the Media Space, the other editors’ Avid applications must 
update their databases to reflect the changes. 

If you see only a few new clips when Refreshing, it takes just a few seconds for 
the files to get scanned and for your database to get updated. However, if 
hundreds or thousands of new clips appear when Refreshing – if, for example, 
several assistant editors have been capturing clips overnight – it can take several 
minutes for your Avid to scan all the files and update its database. If multiple 
editors Refresh their Media Space at the same time, the scanning can take longer 
because everyone’s Avid is simultaneously inspecting all these new clips and 
updating their own databases. 

Similarly, if just one media clip is deleted, when the Space is Unshared the 
database files of all other editors are rebuilt from scratch to take into account the 
files that are now missing. 

To reduce the amount of time spent rebuilding media database files, EditShare 
allows users to copy Avid media database files in a Traditional Media Space 
from one user to another, avoiding the need for each user's workstation to 
rebuild its media database separately.

When you are copying a media database file from another user, the safest 
procedure is for you to shut down your Avid program. If you need to continue 
working while the copying takes place, it is essential that you unmount the 
Media Space whose database will be updated before it receives the database 
copy. When the copying is completed, you can remount the Media Space by 
selecting File > Mount All in the Avid application.

Editors can copy media database files using EditShare Connect, while 
Administrators can do it using EditShare Manager. Media database files are 
never copied automatically, regardless of your automatic Share and 
Refresh settings.
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Limited Administration Capabilities on Traditional Spaces

Type of Space Function Additional Options

All Traditional Media Spaces Share Media (for user) User for whom to Share (select one or more)

Refresh Media (for user) User for who to Refresh (select one or more)

Unshare Media User to take control of Media Space

Reshare Media Accept or Reject changes 
Move Media to Trash Instead of Deleting

For details on using Limited Administration tools, see Chapter 6: Acting as a 
Limited Administrator.
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